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Overview
System Configuration

This section shows an example of a camera system configuration.

SELP28135G

SEL1635Z
SELP18200 =
Lens (e e
JI
LA-EAS, LA-EA4 UWP-D11, UWP-D12 HVL-LBPC
T A-Mount Adaptor Wireless Microphone Video Light
ECM-MS2 Package
Microphone
A
S/N/H/G-series MRW-E80
IFU-WLM3
USB Wireless LAN Module XQD Memory Card XQD Card Reader
(supplied)

BP-U30, BP-U60,

g ) B

BC-U1, BC-U2

BP-U60T, BP-U90 Battery Charger
Battery Pack (BC-U1 supplied)
(BP-U30 supplied) @
PXW-FS7 E
000
o0e@o
AC Adaptor (supplied)) L
HXR-IFR5 AXS-R5
Interface Unit Portable
Memory
RMT-845 Recorder
Infrared Remote Control
(supplied)
Grip Remote Control
(supplied)
XDCA-FS7 BP-GL65A, BP-GL95A, BP-L60S,
Extension Unit BP-L80S, BP-FL75
Battery Pack
VCT-FS7
Shoulder Adaptor . Wireless Adaptor
CBK-WA100

1) MPA-ACI (USA and Canada model only)
AC-NB12A (except USA and Canada model)



Location and Function of Paris

For details about the usage and function of each part, see the referenced page.

1. Viewfinder connector (page 21) 12. Accessory shoe
2. REMOTE connector (page 24) 13. Handle record START/STOP button
3. INPUT1 (LINE/MIC/MIC+48V) switch The record button cannot be operated when the
(page 40) lock lever is in the lock position.
4. INPUT2 (LINE/MIC/MIC+48V) switch 14. Handle zoom lever (page 61)
(page 40) 15. Multi-interface shoe
5. Grip attachment (page 24)
° .
6. USB wireless LAN module connector m Il\rqye!;lface Shoe

7. Recording indicator (page 85)
Flashes when the remaining capacity on the
recording media or battery is low.

For details about accessories supported by the
multi-interface shoe, contact your sales
representative.
8. Tape measure hook

The tape measure hook is on the same plane as

the image sensor. To measure the distance

between the camcorder and the subject

accurately, use this hook as a reference point.

You can attach the end of a tape measure to the

hook to measure the distance from the subject.

9. WB SET (white balance set) button
(page 40)
10. Lens lock pin (page 23)
11. Lens release button (page 23)



Attaching the Accessory Shoe

1 Lift the front edge of the shoe spring, and pull the
spring in the opposite direction to the arrow engraved
on the spring.

Shoe spring

Accessory shoe

2 Position the accessory shoe on the accessory shoe
mount, aligning the protrusions on the shoe with the
corresponding points on the mount, and tighten the
four screws.

3 Insert the shoe spring in the direction of the arrow so
that the U-shaped portion fits onto the end of the
accessory shoe.

-7
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Shoe spring

Removing the Accessory Shoe

Remove the show spring as described in step 1 in
“Attaching the Accessory Shoe,” unscrew the
four screws, and remove the accessory shoe.
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1. START/STOP button

2.ND FILTER switch (page 39)
3. ASSIGN (assignable) 1 to 3 buttons
(page 42)

4. PUSH AUTO IRIS button (page 38)

5. PUSH AUTO FOCUS button (page 36)

6. FOCUS switch (page 36)

7. DISPLAY button (page 13)

8. FULL AUTO button (page 35)

9. POWER switch (page 18)
10. IRIS dial (page 42)
11. STATUS CHECK button (page 15)
12. HOLD switch (page 85)
13. CH1 (AUTO/MAN) switch (page 40)
14. AUDIO LEVEL (CH]1) dial (page 40)
15. CH2 (AUTO/MAN) switch (page 40)
16. AUDIO LEVEL (CH?2) dial (page 40)

17. SLOT SELECT (XQD memory card
select) button (page 27)

18. CANCEL/BACK button (page 52)
19. MENU button (page 54)
20. THUMBNAIL button (page 51)

21.

22.

23.

24.
25.

26.

21.
28.

e== 0 |
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Right button

Used to set numeric values and to move the
cursor to the right on thumbnail screens and
menus.

SEL/SET (select/set) dial

Turn the dial to move the cursor up/down to
select menu items or settings. Press to apply the
selected item.

Left button

Used to set numeric values and to move the
cursor to the left on thumbnail screens and
menus.

SHUTTER button (page 39)

WHT BAL (white balance memory select)
switch (page 39)

WHT BAL (white balance) button
(page 39)

GAIN (gain select) switch (page 38)
ISO/Gain button (page 38)
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1. Headphone connector (page 37)
2.XQD card slot A (page 27)

3. SD card (for saving configuration data)
slot (page 28)

4.XQD (A) access indicator (page 27)
9. SD card access indicator (page 28)
6. XQD (B) access indicator (page 27)

7. USB connector
Connect to a computer using a USB cable to
access recording media in an XQD card slot on
the camcorder.

8. XQD card slot B (page 27)
9. Built-in speaker (page 37)
10. Media cover release button (page 27)
11. Extension unit connector (page 29)
12. Rear recording indicator (page 35)
13. DC IN connector (page 19)
14. BATT RELEASE (battery release) button
(page 18)
15. Battery (page 18)
16. Battery pack attachment (page 18)
17. Infrared remote control receiver sensor
(page 32)
18. Internal microphone (page 40)

19. INPUT1 (audio input 1) connector
(page 40)
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20. INPUT?2 (audio input 2) connector
(page 40)

21. SDI OUT 1 connector (page 89)

22.SDI OUT 2 connector (page 89)

23. HDMI OUT connector (page 89)

Underside

1. Tripod screw hole (1/4 inch, 3/8 inch)
Compatible with 1/4-20UNC screws and 3/8-
16UNC screws.

Attach to a tripod (option, screw length of
5.5 mm or less).



Viewfinder Grip Remote Control

For details about attaching the viewfinder For details about attaching the grip remote control
(supplied) and eyepiece, see page 21. (supplied), see page 24.

1. CONTRAST knob

2. PEAKING button

3. ZEBRA button 5
4. MIRROR switch

5. Eyepiece attachment hooks 7
8
Eyepiece

For details about attaching the eyepiece
(supplied), see page 22.

1. Zoom lever

2. ASSIGN (assignable) 4 button
3. Assignable dial

4. ASSIGN (assignable) 6 button
9. Record START/STOP button
6. Multi selector

1. Diopter adjustment knob
1. Grip rotation button

8. ASSIGN (assignable) 5 button

2. Eyecup

Lens (PXW-FS7K only)

For details, refer to the operation manual for the
lens.

11



Infrared Remote Control

AN OOl 5 WN =

1. DATA CODE button

Not used on this version.
2. TC RESET button
3. SCAN/SLOW button
4. l4<¢/»»| (PREV/NEXT) button
5. PLAY button
6. STOP button
7. DISPLAY button
8. Remote control transmitter
9. START/STOP button
10. Zoom lever
11. PAUSE button

12. MODE button
Not used on this version.

13. €4/»/A/Y/ENTER button
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Extension Unit (Option)

For details about attaching an extension unit
(option), see page 29.

1. BATT RELEASE button
2. Battery connector
3. GENLOCK IN
4.DCIN
5.DC OUT
6. Recording indicator
7.REF OUT
8. TC INJOUT
9. TC IN/OUT switch
10. RAW OUT



Screen Display

Viewfinder Screen

During shooting (recording/standby) and playback, the camcorder status and settings are superimposed
on the image displayed in the viewfinder.

You can show/hide the information using the DISPLAY button.

You can also select to show/hide each item independently (page 72).

The 17:9 aspect ratio picture captured by the image sensor is displayed in the viewfinder. In 16:9 recording
formats, the dark portions on the left and right edges are not recorded.

Information displayed on the screen while shooting

1 2 3 4 5 6 7 8 910 1 1
(o/ ooooQJ[ 00000! |ﬁStbv] [EXTRAT] HA : ]J 0000K J
38 —{[F1.6) (nD1/128000m) (55 s 450 52 OOFPS 096x2160)— 12
37—z ) 69.94P— 13
xavc[—14
36 —{(<G) stD1— 15
35 —(wmF) [EXT RAW 4K[— 16
34 —{[A:sht) _|_ EXTLK[— 17
33 —{/AGC ON) [@wi-Fi)}—18
32 —{(Alris 19
31 —{|AEF+0.00 20
30 —(Aw) = A 21
29 — S ip Name
28 —(=8(©) :
(7G00:00:00:00) | |[9%° & st (== | (A7 000min [ & 7000min |
|
27 26 25 24 23 22
1. Shutter mode/shutter speed indicator 5. Recording mode, slot A/B icon, and status
(page 39) indicators
2. ND filter indicator (page 39) S8Q[A]/[B]@Rec  Slow & Quick Motion,
3. Gain indicator (page 38) High Frame Rate mode
Displayed as an EI value when Base Setting recording
(page 82) >Shooting Mode in the System menu s&Q[Al/[B| Stoy Slow & Quick Motion,
is set to “Cine EL.” High Frame Rate mode
4. Focus position indicator standby
Displays the focus position (if a lens that 'Al/B| ®Rec Recording
supports focus setting display is attached). / Stby Standby
/B @® Picture cache recording

/|B| @Cache Picture cache standby

13



6.

1.

11.

12.

13.

14.

15.

16.

17.

18.

19.

20.

Slot B icon and status indicators

Recording

®Rec

[B] Sty Standby

External RAW recording indicator
(page 46)

. Depth-of-field indicator
. Color temperature indicator (page 39)

. S&Q Motion frame rate indicator

(page 77)
Remaining battery capacity/DC IN
voltage indicator (page 18)

Recording format (picture size) indicator
(page 82)

Displays the picture size for recording on
XQD memory cards.

Recording format (frame rate and scan
method) indicator

Recording format (codec) indicator
(page 38)

Displays the name of the format for
recording on XQD memory cards.

Gamma/monitor LUT indicator (page 65,
page 71)

Displays the gamma setting. When Shooting
Mode (page 82) is set to “Cine EL,” it
displays the gamma or monitor LUT setting
for recording video on XQD memory cards.

External output format indicator
(page 70)

Timecode external lock indicator
Displays “EXT-LK” when locked to the
timecode of an external device.

Wi-Fi connection status indicator

(page 47)

Displayed when the Wi-Fi function is set to
“Enable.” When the IFU-WLM3 is not
attached to the camcorder, m is not
displayed.

GPS status indicator (page 46)

Displays the GPS status.

Focus assist indicator (page 43)

Displays a detection frame (focus area
marker) indicating the area for detection of
focus, and a level bar (focus assist indicator)
indicating the degree of focus within that
area.
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21.

22.

23.

24.
25.
26.
21.
28.
29.

30.

31.
32.
33.
34.
35.
36.
37.

38.

Video signal indicator (page 16)
Displays a waveform, vectorscope, and
histogram.

Slot A/B media status/remaining capacity
indicator (page 27)

Recording media when the left side of the
icon is orange.

Playback media when the green indicator on
the top right of the icon is on.

Spirit level indicator
Displays the horizontal level and the front-to-
rear slope in +1° increments up to +20°.

Audio level meter

Clip name indicator (page 51)
Focus indicator

Time data indicator (page 41)
SD card indicator

SDI output control status indicator
(page 89)
White balance mode indicator (page 39)

W:P Preset mode
W:A Memory mode A
W:B Memory mode B

AE mode indicator (page 38)

Auto iris indicator (page 38)

AGC indicator (page 38)

Auto shutter indicator (page 39)
Focus mode indicator

Image stabilization mode indicator

Zoom position indicator

Displays the zoom position in the range 0 (wide
angle) to 99 (telephoto) (if a lens that supports
zoom setting display is attached).

Iris position indicator
Displays the iris position (if a lens that supports
iris setting display is attached).



Information displayed on the screen during
playback

The following information is superimposed on
the playback picture.

1 2

({0001/0012 ciips)

@ 7
A001C001_1234567A
[TCR00:00:00:00) [ Syl — 8

| |
10 9
. Clip number / total number of clips
. Playback mode
. Remaining battery capacity indicator
. Playback format (picture size) indicator
. Playback format (frame rate) indicator

. Playback format (codec) indicator

~N O Ol S W N =

. Wi-Fi connection status indicator
(page 47)
Displayed when the Wi-Fi function is set to
“Enable.” When the IFU-WLM3 is not
attached to the camcorder, m is not
displayed.

8. Media indicator

9. Audio level indicator
Displays the audio level when recording.

10. Time data indicator
When Display On/Off >Timecode in the VF
menu is set to “On,” it displays the time data
when the DISPLAY button is pressed.
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Status Screen

To display the status screen:
* Push the STATUS CHECK button.

To switch to the status screen:
e Turn the SEL/SET dial.
* Move the multi selector up/down.

To hide the status screen:
¢ Push the STATUS CHECK button.

Camera Status screen
Displays the electronic shutter setting of the
camera and the lens status.

ISO/Gain/ElI<H> ISO/Gain/EI<H> setting

ISO/Gain/EI<M>  ISO/Gain/EI<M> setting

ISO/Gain/EI<L>  ISO/Gain/EI<L> setting

Shutter Shutter setting (Speed/Angle/
ECS/Off)

Iris F-stop value obtained from the
lens

Zebral Zebral On/Off setting and level

Zebra2 Zebra2 On/Off setting and level

Gamma Gamma Select setting

White White balance mode and settings

Focal Length Focal length value obtained from
the lens

AE Level AE level setting

AE Speed AE control speed setting

AGC Limit Maximum gain setting of the AGC
function

A.SHT Limit Fastest shutter speed of the auto
shutter function

AE Mode AE mode setting (Backlight/

Standard/Spotlight)




Audio Status screen

Displays the input setting, audio level meter, and

wind noise reduction filter setting for each

channel.

CHI1 level meter

Channel 1 audio level meter

CHI1 Source

Channel 1 input source

CH1 Ref./Sens.

Channel 1 input reference level

CH1 Wind Filter

Channel 1 microphone wind
reduction filter setting

CH2 level meter

Channel 2 audio level meter

CH2 Source

Channel 2 input source

CH2 Ref./Sens.

Channel 2 input reference level

CH2 Wind Filter

Channel 2 microphone wind
reduction filter setting

Monitor CH

Monitor channel setting

Headphone Out

Headphone output type setting

System Status screen
Displays the video signal settings.

Country

NTSC or PAL region setting

Rec Format

Format for recording to XQD
memory cards

Picture Size

Picture size for recording to XQD
memory cards

Frame Rate

Frame rate for recording to XQD
memory cards

Rec Function

Enabled special recording format
and settings

Simul Rec

Simul Rec On/Off status

Picture Cache Rec

Picture Cache Rec On/Off status

Video Light Set

HVL-LBPC Video Light on/off
indicator

16

Video Output Status screen
Displays the SDI, HDMI, and video output

settings.

SDI1

Output picture size
Color space

Screen display output
Gamma

SDI2

Output picture size
Color space

Screen display output
Gamma

HDMI

Output picture size
Color space

Screen display output
Gamma

REF

Output picture size

RAW

Output picture size

Assignable Button Status screen
Displays the functions assigned to each of the
assignable buttons.

1

Function assigned to the ASSIGN
1 button

2 Function assigned to the ASSIGN
2 button

3 Function assigned to the ASSIGN
3 button

4 Function assigned to the ASSIGN
4 button

5 Function assigned to the ASSIGN
5 button

6 Function assigned to the ASSIGN
6 button

IRIS Dial Function assigned to the IRIS dial

Assignable Dial ~ Function assigned to the

assignable dial

Battery Status screen
Displays information about the battery and DC IN

source.

Detected Battery ~ Type of battery

Remaining Remaining capacity (%)
Charge Count Number of recharges

Capacity Remaining capacity (Ah)
Voltage Voltage (V)

Manufacture Date Date of battery manufacture
Video Light Displays the remaining capacity
Remaining of the video light battery.

Power Source

Power supply source

Supplied Voltage

Supplied power source voltage




Media Status screen
Displays the remaining capacity and remaining
recording time of recording media (XQD memory

cards A and B).
Media A Displays the media icon when
information recording media is inserted in slot
A.
Media A Displays the lock icon when the
protection recording media inserted in slot A
is protected (locked).
[ Note
XQD memory cards cannot be
protected using the camcorder.
Media A Displays the remaining capacity
remaining of recording media inserted in slot

capacity meter

A expressed as a percentage on a
bar graph.

Media A
remaining
recording time

Displays an estimate of the
remaining recording time of the
recording media inserted in slot A
in units of minutes under the
current recording conditions.

Media B Displays the media icon when
information recording media is inserted in slot
B.
Media B Displays the lock icon when the
protection recording media inserted in slot B
is protected (locked).
 Note |
XQD memory cards cannot be
protected using the camcorder.
Media B Displays the remaining capacity
remaining of recording media inserted in slot

capacity meter

B expressed as a percentage on a
bar graph.

Media B
remaining
recording time

Displays an estimate of the
remaining recording time of the
recording media inserted in slot B
in units of minutes under the
current recording conditions.

SD card
information

Displays the media icon when
media (for saving configuration
data) is inserted in the SD card
slot.

SD card protection

Displays the lock icon when the
media inserted in the SD card slot
(for saving configuration data) is
protected (locked).

SD card remaining

capacity meter

Displays the remaining capacity
of media inserted in the SD card
slot (for saving configuration data)
expressed as a percentage on a bar
graph.
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SD card remaining Displays the remaining capacity

capacity of media inserted in the SD card
slot (for saving configuration data)
expressed in units of GB.

SD card life Displays the operating life of

media in the SD card slot (for
saving configuration data) as a
percentage.

Rec Button Settings Screen
Displays the settings of the record START/STOP
buttons on the camcorder and handle.

Rec Button Displays the slots for recording
controlled by the recording
START/STOP button.

Handle Rec Displays the slots for recording

Button controlled by the recording

START/STOP button on the
handle.




Preparation

Power Supply

You can use a battery pack or AC power supply
from an AC adaptor.

For safety, use only the Sony battery packs and
AC adaptors listed below.

Lithium ion battery packs
BP-U30 (supplied)
BP-U60

BP-U60T

BP-U90

Battery chargers
BC-Ul1 (supplied)
BC-U2

AC adaptor (supplied)
MPA-AC1 (USA and Canada model only)
AC-NBI12A (except USA and Canada model)

Do not store battery packs in locations exposed to
direct sunlight, flame, or high temperature.

* The camcorder cannot be powered from the BC-U1/
BC-U2 battery charger acting as an external power
source.

* When operating from a power outlet, use the supplied
AC adaptor.

Using a Battery Pack

To attach a battery pack, plug the battery pack
into the attachment (page 10) as far as it will go,
and then slide it down to lock it into position.

18

To remove a battery pack, press and hold the
BATT RELEASE button (page 10), slide the
battery pack up and then pull it out of the
attachment.

\V§\
i

BATT RELEASE
button

» Before attaching a battery pack, charge the battery
using the dedicated BC-U1 or BC-U2 battery charger.

* Charging a battery immediately after use while it is
still warm may not fully recharge the battery.

Checking the remaining capacity

When shooting/playing using a battery pack, the
remaining battery capacity is displayed in the
viewfinder (page 13).

Remaining capacity

91% to 100%

71% to 90%

51% to 70%

31% to 50%

11% to 30%

BNANELE

0% to 10%

The camcorder indicates the remaining capacity
by calculating the available time with the battery
pack if operation is continued at the current rate
of power consumption.



When using an extension unit

When using the XDCA-FS7 Extension Unit, the
battery voltage or the remaining battery capacity
is displayed, depending on the battery used.

The camcorder battery pack cannot be used when an
XDCA-FS7 unit is attached to the camcorder. You must
attach a battery pack to the XDCA-FS7 or connect an
external power supply.

If the battery pack charge hecomes low

If the remaining battery charge falls below a
certain level during operation (Low BATT state),
a low-battery message appears, the recording
indicator starts flashing, and a beep sound will
warn you.

If the remaining battery charge falls below the
level at which operation cannot continue (BATT
Empty state), a battery-empty message appears.
Replace with a charged battery pack.

Changing the warning levels

The Low BATT level is set to 10% of full battery
charge and the BATT Empty level is set to 3% by
factory default. You can change the warning level
settings using Camera Battery Alarm (page 87) in
the System menu.
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Using AC power

Connecting the camcorder to a power outlet
allows use without worrying about the need to
recharge the battery pack.

DC IN connector

—__ AC adaptor

Y

To wall outlet

Power cord

Connect the AC adaptor to the DC IN connector
on the camcorder, and connect the power cord
(supplied) to a power outlet.

If the output voltage from the AC adaptor
bhecomes low

If the output voltage from the AC adaptor falls
below a certain level during operation (DC Low
Voltagel state), a message appears informing you
that the AC adaptor output voltage has dropped,
the recording indicator starts flashing, and a beep
sound is emitted.

If the output voltage from the AC adaptor falls
below the level at which operation cannot
continue (DC Low Voltage?2 state), a message
appears informing you that the AC adaptor output
voltage is too low.

If this occurs, the AC adaptor may be faulty.
Check the AC adaptor, as required.

Changing the warning levels

The DC Low Voltagel level is setto 11.5 V and
the DC Low Voltage2 level is set to 11.0 V by
factory default. You can change the warning level
settings using Camera DC IN Alarm (page 87) in
the System menu.



AC adaptors

* Do not connect and use an AC adaptor in a
confined space, such as between a wall and
furniture.

* Connect the AC adaptor to the nearest power
outlet. If a problem occurs during operation,
immediately disconnect the power cord from
the outlet.

* Do not short-circuit the metal parts of the plug
of the AC adapter. Doing so will cause a
malfunction.

* The battery cannot be charged while attached to
the camcorder, even if the AC adaptor is
connected.
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Attaching Devices

Attaching the Microphone Holder
 Notes

* The microphone holder is attached when shipped from
the factory.

» Attach/remove the microphone holder while the
camcorder is turned off.

 Attach/remove the microphone holder with the mount
cap attached so as not to damage the image sensor.

1 Insert the microphone holder into the
handle.

2 Insert the stopper into the recess, and
tighten the screw to secure the holder.




Removing the microphone holder

Adjusting the angle of the viewfinder

Remove the stopper, and use the reverse
procedure of attaching the microphone holder.

Attaching the Viewfinder
 Note |

Attach/remove the viewfinder while the camcorder is
turned off.

1 Loosen the viewfinder clamp and insert
the viewfinder onto the protrusion on
the front of the handle.

2 Adjust the left/right positioning of the
viewfinder, tighten the clamp, and then
connect the viewfinder cable to the

viewfinder connector of the camcorder.

Check that the viewfinder is securely attached. The
viewfinder may fall off during shooting if the clamp is
loose.
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Tilt the viewfinder up/down to adjust the angle of
the viewfinder.

You can adjust the angle so that the viewfinder is
facing the subject. Setting the MIRROR switch
(page 44) to the B/T flips the left and right sides
of the image on the LCD screen, but the image is
recorded in the correct orientation.

Adjusting the viewfinder contrast
Turn the CONTRAST knob to adjust the contrast.

You can adjust the brightness in the viewfinder
using VF Setting >Brightness (page 72) in the VF
menu.

Removing the viewfinder

Loosen the viewfinder clamp, and use the reverse
procedure of attaching the viewfinder.



Attaching the Eyepiece Opening the eyepiece

Press the button indicated by the arrow.

Attach/remove the eyepiece while the camcorder is
turned off.

1 Attach the metal clips of the eyepiece to
the eyepiece attachment hooks on the
viewfinder.

Open the eyepiece upwards when the lock
disengages. The viewfinder is directly visible
when the eyepiece is opened.

Eyepiece attachment hooks

2 Push the lock plate on the bottom of the
eyepiece in the direction of the arrow to
lock the eyepiece into position.

Removing the eyepiece

Unclip the eyepiece lock, and remove the
eyepiece from the viewfinder.
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Attaching a Lens

Recommended lenses
SELP28135G
SEL1635Z
SELP18200

For details about lenses supported by the camcorder,
contact your Sony service representative.

Do not leave the lens facing the sun. Direct
sunlight can enter through the lens, be focused in
the camcorder, and may cause a fire.

¢ Attach/remove a lens while the camcorder is turned
off.

* A lens is a precision component. Do not place the lens
on a surface with the lens mount face down. Attach the
supplied lens mount cap.

Attaching an E-mount lens

1 Remove the lens cap and cover from the
camcorder and the lens.
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2 Align the lens mount mark (white) with
the camcorder, carefully insert the lens,
and then turn the lens clockwise.

The lens makes a click sound when it locks
into position.

Mount mark (white)

Attaching an A-mount lens

To use an A-mount lens, attach a lens mount
adaptor (option) and then attach the A-mount
lens.

* When using an A-mount lens, Iris is set to manual.
* When focus is set to AF with an LA-EA2 or LA-EA4
attached, Iris is set to F3.5 or fully open.

Removing a lens

Remove a lens using the following procedure.

1 Press and hold the lens release button
and turn the lens counterclockwise.

2 Pull the lens out in the forward
direction.

If another lens will not be attached immediately, fit the
lens mount into the recess part of the lens mount cap and
turn clockwise.

Iris adjustments for lenses with Auto Iris
switch

¢ When the lens Auto Iris is set to AUTO, the iris
is adjusted automatically and can also be
adjusted manually from the camcorder.

* When the lens Auto Iris is set to MANUAL, the
iris can only be adjusted using the lens ring. Iris
operation from the camcorder has no effect.



Focus adjustments for lenses with focus
switch

* When the lens focus switch is set to AF/MF or
AF, the focus is adjusted automatically and can
also be adjusted manually from the camcorder.

* When the lens focus switch is set to Full MF or
MF, the focus can only be adjusted using the
lens ring. Focus operation from the camcorder
has no effect.

Attaching the Grip Remote Control
 Note

Attach/remove the grip remote control while the
camcorder is turned off.

1 Attach the arm to the grip attachment,
and tighten the screw.
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2 Connect the grip remote control cable
to the REMOTE connector on the
camcorder.

* Check that the arm and grip remote control are
securely attached. They may fall off during shooting if
the screws are loose.

* Do not support the weight of the camcorder by holding
just the grip remote control.

Adjusting the position of the grip remote
control

Adjust the arm angle (D).

Loosen the two screws on the rear side of the arm
using a coin or similar object, adjust the arm
length (@), and then tighten the two screws.
Press the grip rotation button (page 11) to adjust
the angle of the grip remote control (®).




Removing the grip remote control

1 Disconnect the grip remote control
cable from the REMOTE connector on
the camcorder.

2 Remove the arm from the camcorder.
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Setting the Clock

The initial settings screen appears in the
viewfinder the first time the camcorder is turned
on or after the backup battery has become
completely discharged.

Set the date and time of the internal clock using
this screen.

Time Zone

Time Zone sets the time difference from UTC
(Coordinated Universal Time). Change the
setting as required.

Setting the date and time

Turn the SEL/SET dial (page 9) to select items
and settings, then press the SEL/SET dial to apply
the settings and start the clock running.

Once the settings screen is closed, you can change
the date, time, and time zone settings using Clock
Set (page 86) in the System menu.

If the clock setting is lost because the backup battery
becomes fully discharged due to power being
disconnected for an extended period (no battery pack
and no DC IN power source), the initial settings screen
will be displayed when you next turn the camcorder
on.

While the initial settings screen is displayed, no other
operation, except turning the power off, is permitted
until you finish the settings on this screen.

The camcorder has a built-in rechargeable battery for
storing the date, time, and other settings even when the
camcorder is turned off. For details about the built-in
rechargeable battery, see page 93.




Configuring Basic
Camcorder Operation

Before shooting, configure the basic operation of
the camcorder to suit the application.

Shooting Mode

You can switch the shooting mode between
“Custom” mode to create images flexibly on-site,
and “Cine EI” mode (where the camcorder is
operated similarly to a film camera, with footage
developed in post production).

You can select the mode using Base Setting
(page 82) >Shooting Mode in the System menu.

Color Space

Color Space selects the base color gamut for
recorded signals and output signals.

When the shooting mode is set to Custom mode,
Color Space is set to “Matrix.”

Matrix: Selects the color gamut using the Matrix
setting, similar to conventional video
cameras.

When the shooting mode is set to Cine EI mode,
Color Space selects the color gamut of the video
output with MLUT set to Off.

S-Gamut3.Cine/SLog3: Easy to adjust color
gamut for digital cinema (DCIP3).

S-Gamut3/SLog3: Wide color gamut, for
compatibility with future standard gamuts,
optimized using Sony image distortion
correction technology.

You can select the color gamut using Base Setting
(page 82) >Color Space in the System menu.
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Using XQD Memory
Cards

The camcorder records audio and video on XQD
memory cards (available separately) inserted in
the card slots.

About XQD Memory Cards

Use the following Sony XQD memory cards in
the camcorder.

For details on operations with media from other
manufacturers, refer to the operating instructions
for the media or consult the manufacturer’s
information.

S-series XQD memory cards
H-series XQD memory cards
N-series XQD memory cards
G-series XQD memory cards

The recommended media varies depending on the
recording format. For details, contact your Sony
sales representative.

The use of memory cards other than Sony XQD
memory cards is not guaranteed.

For details about using XQD memory cards and
usage precautions, refer to the operating instructions
for the XQD memory card.

XQD is a trademark of Sony Corporation.



Inserting an XQD Memory Card

1 Press the media cover release button
(page 10) to open the media cover of the
card slot section.

2 Insertan XQD memory card with the
XQD label facing to the left.

The access indicator (page 10) is lit red, then
changes to green if the card is usable.

3 Close the media cover.

The memory card, memory card slot, and image data on
the memory card may be damaged if the card is forced
into the slot in the incorrect orientation.

Ejecting XQD Memory Cards

Press the media cover release button (page 10) to
open the media cover of the card slot section, and

lightly press the memory card in to eject the card.

If the camcorder is turned off or the memory card is
removed while the memory card is being accessed, the
integrity of data on the card cannot be guaranteed. All
data recorded on the card may be discarded. Always
make sure the access indicator is green or off before
turning off the camcorder or removing the memory
card.

When removing an XQD memory card immediately
after recording is finished, the XQD memory card may
be hot, but this does not indicate a problem.

Switching Between XQD Memory
Cards

When XQD memory cards are loaded in both card
slots A and B, you can switch the card used for
recording by pressing the SLOT SELECT button
(page 9).

If a card becomes full during recording, the
camcorder automatically switches to the other
card.

The SLOT SELECT button is disabled during playback.
The memory cards are not switched even if you press the
button. The button is enabled while the thumbnail screen
(page 51) is displayed.
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Formatting (Initializing) XQD
Memory Cards

If an unformatted XQD memory card or an XQD
memory card that was formatted in a different
specification is inserted, the message “Media
Needs to be Formatted” is displayed in the
viewfinder.

Format the card using the following procedure.

Select Format Media (page 79) >Media(A)
or Media(B) in the Media menu, then select
Execute. When a confirmation message
appears, select Execute again.

A message is displayed while formatting is in
progress, and the access indicator is lit red.
When formatting is completed, a completion
message is displayed. Press the SEL/SET dial to
dismiss the message.

If formatting fails

Protected XQD memory cards and memory cards
not supported by the camcorder cannot be
formatted.

A warning message is displayed. Follow the
instructions to replace the card with a supported
XQD memory card.

Formatting a memory card erases all data, including
recorded video data and setup files.

Checking the Remaining
Recording Time

When shooting (recording/standby), you can
monitor the remaining capacity of the XQD
memory card in each slot using the slot A/B
media capacity indicators in the viewfinder
(page 13).

The remaining recording time is calculated from
the remaining capacity of the media in each slot
and the current video format (recording bit rate),
and is displayed in units of minutes.

A (@ mark is displayed if the media is protected.



XQD memory card replacement timing

* When the total remaining recording time on the
two memory cards becomes less than 5 minutes,
the message “Media Near Full” appears, the
recording indicator starts flashing, and a beep
sound (headphone output) will warn you.
Replace with media that has free space.

If you continue recording until the total
remaining recording time reaches zero, the
message changes to “Media Full” and recording
stops.

Up to approximately 600 clips can be recorded on one
XQD memory card.

If the number of recorded clips reaches the limit, the
remaining recording time indicator becomes “0” and the
message “Media Full” is displayed.
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Using a Utility SD Card

You can save camera configuration data for the
camcorder on an SD card (available separately).
Saved data files can be imported from the SD
card.

Supported SD Cards

SDHC memory cards*
SD memory cards*
* Referred to collectively as “SD cards” in this manual.

Inserting an SD Card

1 Press the media cover release button
(page 10) to open the media cover of the
card slot section.

2 Insert the SD memory card with the SD
card label facing to the left.

The access indicator (page 10) is lit red, then
goes off if the card is usable.

3 Close the media cover.

Ejecting the SD Card

Press the media cover release button
(page 10) to open the media cover of the
card slot section, and lightly press the SD
card in to eject the card.

If the camcorder is turned off or the SD card is
removed while the SD card is being accessed, the
integrity of data on the card cannot be guaranteed. All
data recorded on the card may be discarded. Always
make sure the access indicator is off before turning off
the camcorder or removing the SD card.

Take caution to prevent the SD card from flying out
when inserting/ejecting the card.



Formatting (Initializing) SD Cards

SD cards must be formatted the first time they are
used in the camcorder.

SD cards for use in the camcorder should be
formatted using the format function of the
camcorder. If a message appears when the SD
card is inserted into the camcorder, format the SD
card.

Select Format Media (page 79) >SD Card in
the Media menu, then select Execute. When
a confirmation message appears, select
Execute again.

A message and progress status are displayed
while formatting is in progress, and the access
indicator is lit red.

When formatting is completed, a completion
message is displayed. Press the SEL/SET dial to
dismiss the message.

Formatting an SD card erases all data on the card. The
card cannot be restored.

Checking the Remaining Capacity

You can check the remaining capacity on an SD
card on the Media Status screen (page 17).

A (@ mark is displayed if the SD card is protected.

To use an SD card formatted on the camcorder in
the slot of another device

First, make a backup of the card, then reformat
the card in the device to be used.
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Using the XDCA-FS7

You can add functions to the camcorder, such as
a V-shoe battery or external sync signal, by
attaching an XDCA-FS7 Extension Unit (option)
to the camcorder.

Attaching the XDCA-FS7
[ Notes |

* The camcorder battery pack cannot be used when an
XDCA-FS7 unit is attached to the camcorder. You
must attach a battery pack to the XDCA-FS7 or
connect an external power supply.

» Attach/remove the XDCA-FS7 while the camcorder is
turned off.

1 Remove the battery pack (page 18)
attached to the camcorder.

2 Remove the cover of the extension unit
connector section.




3 Align the protrusions of the XDCA-FS7

with the left and right grooves of the §>\/~"
camcorder and slide all the way in, then i

slide the XDCA-FS7 down into the
connector section.

Removing the XDCA-FS7

Grooves Protrusions

Loosen the two screws on the top of the
XDCA-FS7, and remove the XDCA-FS7 from
4 Tighten the two screws on the top of the the camcorder.
XDCA-FS7 to secure the XDCA-FS7.

Attaching the Battery Pack

Insert the battery pack into the battery pack
attachment on the XDCA-FS7.

The following Sony genuine battery packs are
supported.

Lithium-ion battery packs
BP-GL65A

BP-GL95A

BP-L60S

BP-L80S

BP-FL75

The cover of the extension unit connector
section can be inserted into the top of the
extension unit.
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Removing the Battery Pack

Pull the battery pack out from the battery pack
attachment on the XDCA-FS7 while holding
down the BATT RELEASE button.

Switching the Timecode Input/
Output

You can switch the timecode input/output using
the TC IN/OUT switch (page 12).

For details, see page 91.
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Using an HXR-IFR5 and
AXS-R5

You can record RAW video (page 46) to an
AXS-R5 RAW Recorder (option) using an HXR-
IFRS5 Interface Unit (option) and an XDCA-FS7.
For details about setting up the HXR-IFRS and
AXS-RS, refer to the HXR-IFRS operation
manual.

Connecting the HXR-IFRS5 to the
Camcorder

1 Attach the XDCA-FS7 to the camcorder
(page 29).

2 Connect the RAW OUT connector of
the XDCA-FS7 to the SDI IN (RAW)
connector of the HXR-IFRS5 using an
SDI cable.

HXR-IFR5

Removing the HXR-IFR5

Disconnect the SDI cable from the RAW
OUT connector of the XDCA-FS7.



Using the Infrared
Remote Control

When using for the first time

Pull out the insulating sheet from the battery
holder when using the supplied infrared remote
control for the first time.

Insulating sheet

'S
o

A CR2025 lithium-ion battery is installed in the
battery holder at the factory.

Controlling the camcorder using the
remote control

To use remote control, first turn on the camcorder
and then enable remote control operation.

Use the setup menu to enable/disable the remote
control function.

To enable using the menu

Press the MENU button to switch the camcorder
to menu mode, then set IR Remote (page 87) in
the System menu to On.

Point the remote control at the remote control receiver
sensor on the camcorder.

Set up the camcorder so that the remote control
receiver sensor is not exposed to direct sunlight or
strong light from other sources. Strong light can
prevent proper remote control operation.

Other video decks may operate by mistake when using
the supplied remote control to operate the camcorder.
In this case, switch the remote control mode switch on
the video deck to DVD?2, or shield the remote control
receiver sensor using black paper.
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Changing the battery of the remote
control

The remote control uses a standard CR2025
battery.
Do not use a battery other than the CR2025.

1 Push the tab in, and remove the battery
holder by placing a fingernail in the
groove.

2 Insertanew battery with the + terminal
facing up.

3 Insert the battery holder until it clicks
into place.

&)
Tab }@ %

Do not store battery packs in locations exposed to
direct sunlight, flame, or high temperature.

Replacing the battery with a non-specified battery may

cause device failure. Always replace with the specified

battery.

Dispose of used batteries in accordance with federal and
local laws.



Using Wi-Fi Remote
Control

You can operate the camcorder from a web
browser by connecting a smartphone, tablet, or
other device that supports a web browser to the
camcorder using a wireless LAN connection.
This function is called Wi-Fi remote control.
This function is useful when operating the
camcorder from a remote location, for example,
when the camcorder is mounted on a crane.

For details of the Wi-Fi remote control setup
procedure, see page 50.

Wi-Fi Remote screen (smartphone)

Main screen

Camera Control * Settl ngs
S&Q FPS, Shutter,
25015229 = White, Sensitivity/
Adocont Gain/Exposure Index,
3840 x 2160 XAVC-
oo [ min DCIN 118V Gamma, MLUT, Color
Bars, Auto Black,

Assign Main

Playback Cursor

Auto White, Rec Start/
Stop, Lock, Iris, Focus,
Zoom, Auto Iris, Auto
Shutter, AGC, ATW

Shutter White

1/60 P 3200k
Gamma Auto Iris Auto Shutter
off
ATW

Auto Black
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Playback screen

Camera Control

2501:52:29
A001C001 t
3840 2160

[EN3min [N 13min

1 XAVCH
DCIN 1.8V

Playback  Cursor

Assign Main

/1
Play/Pause

Cursor screen

Camera Control

25018229 =
[ 3min

Assign Main

_é_
Set

Cancel/Back

e

Playback

Assign screen

Camera Control

-
—
1
9.94P
XAVCH

S 3min [N 13min

DCIN 1.8V

Assign Main

°‘ 2Q Motion

Playback  Cursor

°wu
ouw Ment
°v cus Mag
@ user venu
°uu

* Status

* Playback buttons
Play/Pause, Stop, F
Fwd, F Rev, Next, Prev

* Status

¢ Cursor buttons
Up, Down, Left, Right,
Set, Cancel/Back,
Menu, Status,
Thumbnail, User
Menu

* Status

» Assignable buttons
Assignable buttons 1
to 6



Wi-Fi Remote screen (tablet)

Main screen

Camera Control

Connected
¢ W 13min
229 cture Size 3640 2160 | MM 13min

1t XAVC-T

Assign Main Playback  Cursor

Iris OPEN

(825

oo
50m

Lock ™™ Zoom

(0]

S8Q FPS Shutter White
Off 1/60 Pre: 00 STD5

Gamma

Auto Iris
Off Off

Auto Shutter

Gain

Color Bars

off Auto Black

Settings

S&Q FPS, Shutter, White, Sensitivity/Gain/Exposure
Index, Gamma, MLUT, Color Bars, Auto Black, Auto
White, Rec Start/Stop, Lock, Iris, Focus, Zoom, Auto

Iris, Auto Shutter, AGC, ATW

Playback screen

Camera Control

Connected

W 13min

ClipAD01C001
e
W 13min

2 = - Lo

20 c x2160
XAVC-T

Cursor

Assign Main Playback

* Status
* Playback button
Play/Pause, Stop, F Fwd, F Rev, Next, Prev

DCIN11.8V

DCIN11.8V
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Cursor screen

Camera C Connected

% 13min
W 13min

1ip A001C001
DCIN11.8V

25:01:52:29 &

Assign Main Playback  Cursor

“ o

Cancel/Back
set
Thumbnail Status

* Status

» Cursor buttons
Up, Down, Left, Right, Set, Cancel/Back, Menu,
Status, Thumbnail, User Menu

Assign screen

Camera Control

Connected

% 13min

(BN 13min  DCIN118V

25:01:52:29 =

Assign Main Playback  Cursor

[ B
@ user Menu

@ s
@ or

Quserven @

* Status
» Assignable buttons
Assignable buttons 1 to 6



Basic Operation Procedure

Basic shooting is conducted using the following
procedure.

1 Attach the necessary devices, and check
that power is being supplied.

Insert the memory card(s).

3  Set the POWER switch to the ON
position.

The camera image appears in the viewfinder.

4 Press the record button (page 7).

The recording indicator turns on, and the
camcorder starts recording.

5 To stop recording, press the record
button again.

Recording stops, and the camcorder switches
to STBY (standby) mode.

Shooting (Full Auto mode)

Press the FULL AUTO button, turning the button
indicator on.

The auto iris (compatible lenses only), AGC, auto
shutter, ATW (auto tracing white balance)
functions are enabled to control the brightness

and white balance automatically (full auto mode).

To control each function manually, turn Full Auto
mode off.

Recording continuously when changing
memory cards (Relay Rec)

When memory cards are inserted in both slots A
and B, recording automatically switches to the
second memory card just before the remaining
capacity on the first card is reduced to zero.

* Do not eject a memory card while recording to it is in
progress. Only change memory cards in slots for which
the slot access indicator is off.

* When the remaining capacity on the memory card
being recorded becomes less than one minute and a
recordable memory card is inserted in the other slot, a
“Will Switch Slots Soon” message appears. The

message disappears after switching memory card slots.
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Relay recording may not operate if recording is started
when the remaining memory card capacity is less than
one minute. For correct relay recording, check that the
remaining memory card capacity is more than one
minute before starting recording.

Video created using the camcorder relay recording
function cannot be played back seamlessly on the
camcorder.

To combine video created using the camcorder relay
recording function, use Content Browser software.

Recording to memory cards A and B
simultaneously (Simul Rec)

You can simultaneously record using both
memory cards A and B.

Set Simul Rec >Setting in the Recording
menu to “On.”

Simultaneous recording is not supported in Slow &
Quick Motion mode (page 77) or Picture Cache
recording mode (page 77).

Also, simultaneous recording is not supported for the
following recording formats (page 82).

NTSC Area
XAVC-I
3840 x 2160 59.94P, 3840 x 2160 29.97P,
3840 x 2160 23.98P, 1920 x 1080 59.94P
XAVC-L
3840 x 2160 59.94P, 3840 x 2160 29.97P,
3840 x 2160 23.98P
RAW (with XDCA-FS7, HXR-IFR5, and AXS-
RS5 connected)
4096 x 2160 59.94P, 4096 x 2160 29.97P,
4096 x 2160 23.98P, 2160 x 1080 59.94P,
2160 x 1080 29.97P, 2160 x 1080 23.98P
RAW & XAVC-I (with XDCA-FS7, HXR-IFRS5,
and AXS-RS5 connected)
4096 x 2160 59.94P, 2160 x 1080 59.94P

PAL Area
XAVC-1
3840 x 2160 50P, 3840 x 2160 25P,
1920 x 1080 50P
XAVC-L
3840 x 2160 50P, 3840 x 2160 25P
RAW (with XDCA-FS7, HXR-IFR5, and AXS-
R5 connected)
4096 x 2160 50P, 4096 x 2160 25P,
2160 x 1080 50P, 2160 x 1080 25P
RAW & XAVC-I (with XDCA-FS7, HXR-IFRS,
and AXS-RS5 connected)
4096 x 2160 50P, 2160 x 1080 50P



Changing the settings of the record
huttons on the camcorder and handle

When the simultaneous recording (Simul Rec) is

enabled, you can start/stop recording to each

memory card independently using the record

START/STOP buttons on the camcorder and the

handle.

By factory default, both buttons are set to start/

stop simultaneous recording to both memory

cards A and B.

¢ “Rec Button [SlotA SlotB] Handle Rec Button
[SlotA SlotB]”

To change the setting

Select Simul Rec >Rec Button Set in the
Recording menu.

Rec Button Set Buttons and memory cards

“Rec Button Starts/stops simultaneously

[SlotA SlotB] recording to memory cards A and

Handle Rec B using either button.

Button [SIotA

SlotB]”

“Rec Button The record START/STOP button

[SlotA] Handle starts/stops recording to memory

Rec Button card A, and the record START/

[SlotB]” STOP button on the handle starts/
stops recording to memory card B.

“Rec Button The record START/STOP button

[SlotB] Handle starts/stops recording to memory

Rec Button card B, and the record START/

[SlotA]” STOP button on the handle starts/

stops recording to memory card A.

Adjusting the Focus Automatically

A lens that supports auto focus is required. Set the
FOCUS switch (page 9) on the camcorder to the
“AUTO” position. If the lens is fitted with a focus
selector switch, set the switch to the “AF/MF” or
“AF” position. If the switch is set to the “Full
MF” or “MF” position, lens focusing cannot be
operated from the camcorder (page 24).

Temporarily stopping auto focus (Focus
Hold)

Press the PUSH AUTO FOCUS button (page 9)
when in auto focus mode to override auto focus.
This is useful, for example, when something
crosses in front of the subject that you do not want
to focus on, or when auto focus is lost.
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Adjusting the Focus Manually

To adjust the focus manually, set the FOCUS
switch (page 9) to “MAN.”
This allows you to adjust the focus manually
according to the shooting conditions.
Manual focusing is useful for the following types
of subjects.
- Subjects on the far side of a window covered
in water droplets
- Subjects with low contrast against the
background
- Subjects further away than nearby subjects

Adjusting focus rapidly using manual
focus (Push Auto Focus)

Position the subject that you want to adjust focus
for in the center of the image, then press the
PUSH AUTO FOCUS button (page 9).

The focus returns to the previous setting when
you release the button.

This is useful when you want to quickly focus on
a subject before starting to shoot.

¢ The Push Auto Focus function does not operate if the
lens is set for manual focusing.

* During Push Auto Focus operation when using an LA-
EA2/4, Full Auto mode is On.

Focus indicator

Indicates the focus state.

¢ (On): Subject is in focus.

* (Flashing): Subject is out of focus. Since
focusing is not automatic, change the
composition and focus settings to achieve
focus.



Focusing using magnified view (Focus
Magnifier)

By factory default, the Focus Magnifier x4/x8
function is assigned to the ASSIGN4 button on
the grip remote control (page 42).

Press the ASSIGN4 button.

The focus magnifier screen appears with the
center magnified by approximately four times.
Press the button again to increase the
magnification to approximately eight times. This
function is useful for checking the focus.

Press the button again to return to the normal
screen.

* The recorded image or SDI/HDMI output image is not
magnified when the focus is magnified.

* During focus magnification, the STATUS CHECK
button and menu buttons have no effect.

Monitoring Audio

You can monitor the audio that is being recorded
using headphones.

Connecting a set of headphones to the headphone
connector (page 10) enables you to monitor the
audio being recorded. You can also monitor the
playback audio (page 52) using the built-in
speaker (page 10) or headphones.

You can select the audio channel to monitor and
adjust the volume using Audio Output (page 69)
in the Audio menu.

Switching Between XQD Memory
Cards

When two XQD memory cards are inserted, press
the SLOT SELECT button (page 9) to switch
cards.

You cannot switch between memory cards during
playback mode. Also, continuous playback of a clip
spanning media in slot A and slot B is not supported.
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Clips (recorded data)

When you stop recording, the video, audio, and
accompanying data from the start to the end of
the recording are saved as a single “clip” on an
XQD memory card.

Clip names

Each clip recorded by the camcorder is
automatically assigned a clip name comprising
the word “Clip” and a 4-digit number. The 4-
digit number automatically increments with
each recording.

You can change the “Clip” prefix using Clip in
the Media menu.

Maximum clip duration

The maximum duration of a clip varies
depending on the recording format.

The maximum duration of continuous recording
is the same as the maximum duration of a clip.
When the recording time reaches the maximum
duration, recording stops.




Changing Basic Settings

You can change the settings based on the video
application or recording conditions.

Selecting the Recording Format

The formats available for selection vary
depending on the Country (region of use) and
Codec settings.

Select a format using Rec Format >Video Format
in the System menu.

Adjusting the Brightness

You can adjust the brightness by adjusting the
iris, gain, shutter speed, and by adjusting the light
level using ND filters.

When adjusting the brightness without using ND
filters, turn Full Auto mode (page 35) off.

You can adjust the brightness control target level
in the setup menu.

Adjusting the control target level
Set the level using Auto Exposure (page 59)
>Level in the Camera menu.

The brightness cannot be adjusted automatically in Cine
EI mode.

Adjusting the iris automatically

This function adjusts the brightness according to
the subject. A lens that supports auto iris is
required.

1 If a lens with Auto Iris switch is
attached, set the switch to AUTO.

2  Press the IRIS button (page 42) to turn
Auto Iris on.

The setting toggles between on and off each
time the IRIS button is pressed.
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Adjusting the iris manually

Press the IRIS button to turn Auto Iris off,
then adjust using the IRIS dial.

You can also assign the IRIS function to an
assignable dial (page 42).

Turning auto iris on temporarily

Press and hold the PUSH AUTO IRIS button to
turn auto iris on temporarily.

The iris returns to the previous setting when you
release the button.

When the Auto Iris switch of the lens is set to
“MANUAL,” the Auto Iris and Push Auto Iris functions
on the camcorder have no effect. Manual iris adjustments
on the camcorder also have no effect.

Adjusting the gain automatically

Press the ISO/Gain button (page 9) to turn AGC
on.

Or select Auto Exposure (page 59) >AGC in the
Camera menu and set to “On.”

Adjusting the gain manually

You can control the gain when you want to adjust
the exposure while using a fixed iris setting or
when you want to prevent the gain increasing due
to AGC.

1 Press the ISO/Gain button (page 9) to
turn AGC off.

2 Set the GAIN switch (page 9) to H, M,
or L.

Controlling the gain (fine adjustment)

Turn the IRIS dial, or the assignable dial assigned
with the ISO/Gain/EI function, to adjust the gain
value set by the GAIN switch.

This is useful when you want to adjust the
exposure by one step without changing the depth
of field.

The adjusted gain value is canceled by switching
the GAIN switch or by turning AGC on.



Shooting using auto shutter

This function adjusts the shutter speed

automatically in response to the image brightness.

Press the SHUTTER button (page 9).

If the settings screen was displayed, press the
button again.

Or set Auto Exposure (page 59) >Auto Shutter in
the Camera menu to On.

Shooting with a fixed shutter

You can shoot with a set shutter speed.

Press the SHUTTER button to display a screen
with the supported shutter values, and select and
set a value using the SEL/SET dial. If you press
the SHUTTER button again instead of the SEL/
SET dial, auto shutter is enabled.

Setting in the Camera menu
Select Shutter (page 61) in the Camera menu and
set the shutter mode and speed.

Adjusting the light level (ND filter)

In conditions where the lighting is too bright, you
can set the appropriate brightness by changing the
ND filter.

Turn the ND FILTER switch (page 9) to select
Clear — 1/4 — 1/16 — 1/64 — Clear in
sequence.

Adjusting for Natural Colors
(White Balance)

You can select the adjustment mode to suit the
shooting conditions.

ATW (auto tracing white balance)

This function adjusts the white balance
automatically to an appropriate level.

The white balance is automatically adjusted when
the color temperature of the light source changes.
Pressing the WHT BAL button (page 9) switches

ATW on/off.
You can select the speed of adjustment (five

steps) using White >ATW Speed (page 63) in the

Paint menu.

You can freeze the current white balance setting

by assigning the ATW Hold function to an
assignable button (page 42), and pressing the
assignable button to temporarily pause ATW
mode.

ATW does not operate in Cine EI mode. Also, when
ATW mode is set to Preset, the available color
temperature options are 3200K, 4300K, and 5500K
only, and the auto white balance function does not
operate.

It may not be possible to adjust to the appropriate
colors using ATW, depending on the lighting and
subject conditions.

Examples:

- When a single color dominates the subject, such as

sky, sea, ground, or flowers.

- When the color temperature is extremely high or
extremely low.
If the appropriate effect cannot be obtained
because the ATW auto tracking speed is slow or
for other reasons, run auto white balance.

Adjusting the white balance manually

1 Turn Full Auto mode (page 35) off.

2 When white balance is set to ATW
mode, press the WHT BAL button
(page 9) to set manual mode.
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3 Select B, A, or PRESET using the WHT
BAL switch (page 9).

B: Memory B mode *

A: Memory A mode
PRESET: Preset mode

* B can be assigned to ATW ON.

Preset mode

This mode adjusts the color temperature to a
preset value (factory default is 3200K).

Memory A/Memory B mode
This mode adjusts the white balance to the setting
saved in memory A or B, respectively.

Running auto white balance

1 Press the ISO/Gain button (page 9) to
turn AGC on.

Or select Auto Exposure (page 59) >AGC in
the Camera menu and set to “On.”

2 To save an adjustment value in
memory, select memory A mode or
memory B mode.

3 Place white paper (or other object) in a
location with the same lighting source
and conditions as the subject, then zoom
in on the paper to show white on the
screen.

4 Adjust the brightness.

Adjust the iris using the procedure in
“Adjusting the iris manually” (page 38).

5 Press the WB SET button (page 7).

If auto white balance is set in memory mode,
the adjustment value is saved in the memory
(A or B) selected in step 2.

If auto white balance is set in ATW mode, the
white balance adjustment returns to the ATW
mode white balance when adjustment ends.

You can enable auto white balance when in preset
mode using White >AWB Enable<P> in the Paint
menu. The setting is disabled again when the
camcorder is turned off.

If the adjustment is not successful, an error message is
displayed on the screen for about three seconds. If the
error message persists after repeated attempts to set
white balance, contact your Sony service
representative.

.
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Setting the Audio to Record

You can specify the audio to be recorded using
the input connectors, switches, and dials of the
camcorder.

External audio input connectors and selector
switches

INPUT1 connector (page 10)

INPUT2 connector (page 10)

INPUT1 switch (LINE/MIC/MIC+48V) (page 7)
INPUT?2 switch (LINE/MIC/MIC+48V) (page 7)

Switches for setting the audio level

CH1 (AUTO/MAN) switch (page 9)
CH2 (AUTO/MAN) switch (page 9)
AUDIO LEVEL (CH1) dial (page 9)
AUDIO LEVEL (CH2) dial (page 9)

Selecting the audio input device

1 Select the audio input connector.

Select the audio input using Audio Input
>CHI Input Select or CH2 Input Select in the
Audio menu.

Setto “INPUT1” or “INPUT2” to correspond
to the connector for the connected device. If
using a shoe microphone, specify “Shoe 1" or
“Shoe 2” in the same way.

2 Select the input audio source.
Set the INPUT1/INPUT?2 (LINE/MIC/
MIC+48V) switches to the devices
connected to the INPUT1/INPUT2
connectors, respectively.

Connected device Switch position

External audio source (e.g. LINE

mixer)

Dynamic microphone, MIC
battery-operated

microphone

+48 V phantom power MIC+48V

feed microphone

* Selecting “MIC+48V” and connecting a
microphone that is not compatible with a
+48 V source may damage the connected
device. Check the setting before connecting
the device.

* If noise is a concern on connectors with no
device connected, set the corresponding
INPUT1/INPUT?2 (LINE/MIC/MIC+48V)
switches to “LINE.”



Adjusting the audio recording level
automatically

Set the CH1/CH2 (AUTO/MAN) switches for the
channels to adjust automatically to “AUTO.”

Adjusting the audio recording level
manually

Use the following procedure to adjust the audio
recording level.

1 Set the CHI/CH2 (AUTO/MAN)
switches for the channels to adjust
manually to “MAN.”

2 During shooting or standby, turn the
AUDIO LEVEL (CH1)/(CH2) dials of
the corresponding channels to adjust
the audio level.

You can also adjust the recording level using
the assignable dial (page 42) if assigned with
the Audio Input Level function, or from the
setup menu.

If Audio Input >CH1 Level and CH2 Level in the
Audio menu are both set to “Side,” Audio Input
Level in the menu is disabled as there is no target
for the Audio Input Level setting. In this case, an
assignable dial with Audio Input Level assigned
also cannot be used to adjust the audio level.

If Audio Input >CH1 Level or CH2 Level in the
Audio menu is set to “Lvl + Side,” the adjustment
value is the product of the Audio Input Level
setting and the level set by the AUDIO LEVEL
dial. If either level is set to the minimum value,
the audio is muted. If both levels are set to the
maximum value, the maximum level is selected.
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Specifying Time Data

Setting the timecode

Set the timecode to record using Timecode
(page 76) in the TC/UB menu.

Displaying time data

Press the DISPLAY button to display time data
on the screen (page 14).

Set the timecode to display using TC Display
(page 76) >Display Select in the TC/UB menu.
Pressing an assignable button (page 42) with
DURATION/TC/U-BIT assigned will switch the
display between the timecode, user bits, and
duration in sequence.



Useful Functions

Assignable Buttons/Dials

There are six assignable buttons (page 9,

page 11) on the camcorder to which you can
assign functions.

You can also assign functions to the IRIS dial
(page 9) on the camcorder and the assignable dial
(page 11) on the grip remote control.

Changing the button function

Use Assignable Button (page 83) in the System
menu.

You can view the assigned functions on the
Assignable Button Status screen (page 16).

The following functions are assigned to each
assignable button by factory default.

Button 1 S&Q Motion

Button 2 IRIS

Button 3 User Menu

Button 4 Focus Magnifier x4/x8
Button 5 User Menu

Button 6 Off

Assignable functions

* Off

* Marker

* Zebra

* Peaking

* Video Signal Monitor
* DURATION/TC/U-BIT
* Focus Magnifier x4/x8
* Focus Magnifier x4

* Focus Magnifier x8

* Push AF/Focus Hold
* VF Mode

« IRIS

* AGC

« SHUTTER

* Auto Exposure Level
* Push Auto Iris

* Push AGC

* Spotlight

* Backlight

« ATW

* ATW Hold

* SteadyShot
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¢ Color Bars

* User Menu

* Rec Lamp

¢ S&Q Motion

* Picture Cache Rec
¢ Rec Review

¢ Thumbnail

e Shot Mark1

¢ Shot Mark?2

* Clip Flag OK

* Clip Flag NG

* Clip Flag Keep
* High/Low Key

Changing the dial function

Use Assignable Dial (page 85) in the System
menu.

You can view the assigned functions on the
Assignable Button Status screen (page 16).
IRIS is assigned by factory default.

Assignable functions
* Off

* IRIS

* ISO/GAIN/EI

* Focus

* Audio Input Level



Slow & Quick Motion

When the video format (page 82) is set to one of
the following values, you can specify a different
value for the recording frame rate and playback
frame rate.

NTSC Area
XAVC-1I
3840 x 2160 59.94P, 3840 x 2160 29.97P,
3840 x 2160 23.98P, 1920 x 1080 59.94P,
1920 x 1080 29.97P, 1920 x 1080 23.98P
XAVC-L
3840 x 2160 59.94P, 3840 x 2160 29.97P,
3840 x216023.98P, 1920 x 1080 59.94P 50,
1920 x 1080 59.94P 35, 1920 x 1080 29.97P
50, 1920 x 1080 29.97P 35, 1920 x 1080
23.98P 50, 1920 x 1080 23.98P 35

PAL Area

XAVC-I

3840 x 2160 50P, 3840 x 2160 25P,

1920 x 1080 50P, 1920 x 1080 25P
XAVC-L

3840 x 2160 50P, 3840 x 2160 25P,

1920 x 1080 50P 50, 1920 x 1080 50P 35,
1920 x 1080 25P 50, 1920 x 1080 25P 35

¢ Slow & Quick Motion cannot be set during recording,
playback, or while the thumbnail screen is displayed.
¢ Audio recording is not supported in Slow & Quick
Motion mode.
¢ The auto focus function is disabled in Slow & Quick
Motion mode.
* The following conditions apply when shooting at
frame rates higher than 60 fps.
- The focus assist indicator, depth of field indicator,
focus position indicator, iris position indicator, and
zoom position indicator are all turned off.
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NTSC Area

Format Resolution Frame High frame
rate rate
XAVC-1 2160 1 to 60 fps —
(59.94P, 29.97P, 23.98P)
1080 1 to 60 fps 72/75/80/90/96/
100/110/120/125/
135/144/150/160/
168/175/180 fps
(59.94P, 29.97P, 23.98P)
XAVC-L 2160 1 to 60 fps —
(59.94P, 29.97P, 23.98P)
1080 1 to 60 fps 72/75/80/90/96/
100/110/120 fps
(59.94P 50,59.94P 35,29.97P
50, 29.97P 35, 23.98P 50,
23.98P 35)
PAL Area
Format Resolution Frame High frame
rate rate
XAVC-I 2160 1to 60 fps —
(59P, 25P)
1080 1 to 60 fps 72/75/80/90/96/
100/110/120/125/
135/144/150 fps
(59P, 25P)
XAVC-L 2160 1to 60 fps —
(59P, 25P)
1080 1 to 60 fps 72/75/80/90/96/
100/110/120 fps
(50P 50, 50P 35, 25P 50,
25P 35)

Picture Cache Recording (Picture
Cache Rec)

The picture cache recording function allows you to
capture video retroactively when you start recording
and then record it to XQD memory cards by
maintaining an internal cache memory of a specified
duration when shooting. The picture cache
recording time is set using Picture Cache Rec
>Cache Rec Time (page 77) in the Recording
menu.

« Picture Cache Rec cannot be on at the same time as
Frame Rec, Interval Rec, or Slow & Quick Motion.
‘When Picture Cache Rec is turned on, these other
recording modes are forcibly turned off.

 Picture Cache Rec mode cannot be selected while
recording or Rec Review is in progress.



* When Picture Cache Rec is on, the timecode is
recorded in Free Run mode regardless of the setting in
the TC/UB menu (page 76).

Configuring before shooting

Configure Picture Cache Rec (page 77) in the
Recording menu before shooting.

You can also assign the Picture Cache Rec
function to an assignable button (page 42) and

switch Picture Cache Rec on/off using the button.

When configured, the @ (green) indicator
appears in the viewfinder (page 13).

Picture cache recording

When you press the record button, recording
starts and video is written to XQD memory cards
starting from the video stored in the cache
memory.

To cancel Picture Cache Rec

Turn off Picture Cache Rec >Setting in the
Recording menu or press an assignable button
assigned with the Picture Cache Rec function.

¢ Changing the recording format clears the video in
cache memory stored up to that point, and starts
caching new video. Consequently, picture cache
recording of pictures before changing format is not
possible, even if you start recording immediately after
changing format.

If Picture Cache Rec is turned on/off immediately after
inserting an XQD memory card, cache data may not be
recorded on the card.

Video is stored in cache memory when the cache
recording function is turned on. Video prior to the
function being turned on is not cached.

Video is not stored in cache memory while an XQD
memory card is being accessed, such as during
playback, Rec Review, or thumbnail screen display.
Picture cache recording of video during that interval is
not possible.

You can change the cache recording time setting using
the menu while recording is in progress, but the new
value does not come into effect until after recording
ends.
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Reviewing a Recording (Rec
Review)

You can check the video of the most recently
recorded clip on the screen.

When recording is stopped, press the
assignable button (page 42) with Rec
Review assigned.

The clip is played to the end, Rec Review ends,
and the camcorder returns to STBY (standby)
mode.

To stop Rec Review
Press the assignable button with Rec Review
assigned.

Rec Review is not supported if the video format is
changed after recording a clip.

Self Portrait Mode

You can flip the image in the viewfinder
(page 11) vertically or horizontally/vertically
using the MIRROR switch.
This allows you to turn the viewfinder 180°
toward the lens.

—

_J

OFF B/T ROT

€0)




OFF

The image is not inverted.

B/T

The image is flipped vertically.

The information display is flipped vertically and
horizontally.

ROT

The image is flipped vertically and horizontally.
The information display is also flipped vertically
and horizontally.

= 000000000

The B/T and ROT view are displayed in the viewfinder
only. The output video and recorded video remain
unaffected.

Displaying Peaking

You can turn peaking on/off by pressing the
PEAKING button on the viewfinder (page 11).
You can turn peaking on/off and set the peaking
type and peaking frequency using Peaking
(page 72) in the VF menu.

Displaying Zebra

You can turn zebra pattern display on/off by
pressing the ZEBRA button on the viewfinder
(page 11).

You can turn zebra pattern display on/off, and set
the zebra pattern type and display level using
Zebra (page 72) in the VF menu.



Obtaining Location Information
(GPS)

Set GPS to ““On” in the System menu.

Q is displayed when the camcorder is seeking
GPS satellites. When positioning is established,
location information is recorded when shooting
video.

* The GPS setting in the System menu cannot be turned
on/off when the handle is not attached.

» The icon displayed varies, depending on the signal
reception from the GPS satellites.

Positioning Display  GPS reception state

status
Off No display ~ GPS is set to “Off” or an
error occurred.
Positioning NO GPS Location information
not available SIGNAL could not be obtained
because GPS signal
could not be received.
Move to a location with a
clear view of the sky.
Searching for P Searching for GPS
satellites O\Q satellites. Several
minutes may be required
to acquire satellites.
Positioning A weak GPS signal is

¢
O‘. being received.

A GPS signal is being

4
".I received. Location
information can be
acquired.
\' I A tstrong QPS signal 1%
o2l being received. Location

information can be
acquired.

* GPS is set to “On” by factory default. Location and
time information of video shot when positioning is
enabled is recorded by the camcorder.

If a positioning icon is not displayed after several
minutes, there may be a problem with signal reception.
Start shooting without location information, or move
to an area with a clear view of the sky. Shooting when
a positioning icon is not displayed means that location
information will not be recorded.

The GPS signal may not be received when indoors or
near tall structures. Move to a location with a clear
view of the sky.

The recording of location information may be
interrupted, depending on the strength of the received
signal, even if a positioning icon is displayed.
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Shooting in Cine EI Mode

This mode mimics the way a film camera works,
and assumes “developing” occurs in post-
production.

Cine El mode constraints

* Functions that cannot be adjusted automatically
(tracking)
- White balance
- Gain
- Shutter
- Iris
- Auto Exposure
* Functions that cannot be configured
- Gain
- Noise Suppression
- Paint menu settings
- Scene File
- Lens File

Functions available in Cine El mode only

* Exposure Index
* Monitor LUT
* RAW video recording

Recording RAW Video

You can record RAW video to an AXS-R5
(option) by converting the signal output from the
RAW OUT connector of an XDCA-FS7 (option)
attached to the camcorder using an HXR-IFRS
(option) (page 31).

1 Set up the external RAW recorder unit
(page 31).

2 Set Codec >Select in the System menu to
RAW.
Selecting RAW & XAVC-I will
simultaneously record RAW video to the
external RAW recorder and HD video to the
XQD memory cards in the camcorder.

3 Set Rec Format in the System menu to
RAW Output Format.

4 Check that the external recorder is
turned on, then press the record button
on the camcorder.



The supported RAW output formats are shown

below.

NTSC Area

Codec >Select RAW output formats
setting

RAW / RAW & 4096 x 2160 59.94pP

XAVC-1/RAW &
XAVC-L/RAW &

4096 x 2160 29.97P
4096 x 2160 23.98P

Connecting Devices
using Wireless LAN

The camcorder can connect to smartphones,
tablets, and other devices using wireless LAN
connection by attaching the IFU-WLM3 USB

MPEG HD422 2048 x 1080 59.94P
2048 x 1080 29.97P
2048 x 1080 23.98P

PAL Area

Codec >Select RAW output formats

setting

RAW /RAW & 4096 x 2160 50P

XAVC-1/RAW &
XAVC-L/RAW &
MPEG HD422

4096 x 2160 25P
2048 x 1080 50P
2048 x 1080 25P

Recording status indicator

If Display On/Off (page 74) >HXR-IFRS Rec
Control in the VF menu is set to “On,” the RAW
recording status is displayed in the viewfinder
using an icon.

Slow & Quick Motion Recording

If S&Q Motion >Setting in the Recording menu is
set to “On,” RAW video is recorded in Slow &
Quick Motion mode.

RAW output Slow & Quick Motion is supported
only for 2K resolution at 120/240 fps (NTSC) and
100/200 fps (PAL).

The RAW OUT connector of the camcorder only
controls recording by transmitting a Rec Control signal
to the external recorder, hence the camcorder may
indicate RAW video recording is in progress when the
external recorder is not actually recording. Check the
indicator on the external recorder to obtain the correct
operating status.

Wireless LAN Module (supplied) or a
CBK-WA100 Wireless Adaptor (option).

USB wireless modules other than the IFU-WLM3 are not

supported.

The following are supported from devices connected by

wireless LAN.

* Remote control
Enables remote control of the camcorder.

* Video and audio monitoring (CBK-WA100 only)
Enables monitoring of the video and audio from the
camcorder.

CBK-WA100 (option) and the Content Browser
Mobile application are required.

For details about the Content Browser Mobile
application, contact your Sony sales or service
representative.

Compatible Devices

You can use a smartphone, tablet, or computer to
configure and operate the camcorder. The
supported devices, OS, and browsers are shown
in the following table.

Device 0S Browser
Smartphone  Android 4.3 Chrome
i0S7 Safari
Tablet Android 4.3 Chrome
i0S7 Safari
Computer Microsoft Windows 7/ Chrome
Microsoft Windows 8.1
Mac OS 10.8/10.9 Safari
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Attaching the IFU-WLM3

Plug the IFU-WMLJ3 into the USB wireless LAN
module connector (page 7).

After attaching the unit, set Wi-Fi >Wi-Fi

(page 86) in the System menu to “Enable” to
enable wireless LAN.

Attach/remove the IFU-WLM3 while the camcorder is
turned off.

Attaching the CBK-WA100
 Note|

Attach/remove the CBK-WA100 while the camcorder is
turned off.

1 Attach the CBK-WA100 to the
mounting bracket, and tighten the two
screws.

2 Attach the CBK-WA100 mounting
bracket on the camcorder, and tighten
the screws.
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Connect the CBK-WA100 USB cable to
the USB wireless LAN module
connector (D), and the SDI cable to the
SDI OUT connector (®).

Turn the CBK-WA100 on, and then
turn the camcorder on.

When connection is completed, the
wireless LAN must be enabled by
setting Wi-Fi >Wi-Fi (page 86) in the
System menu to Enable.



The SDI OUT output setting must be configured to use
the CBK-WA100 with the camcorder (page 77).

About the CBK-WA100

The CBK-WA100 has functions for recording
proxy files (low-resolution files) on an SD card,
and for transferring the files to a server via a
wireless LAN. For details, refer to the operation
manual for the CBK-WA100.

One-touch Connection of NFC-
enabled Devices (Using IFU-
WLMS3 Only)

Devices that support NFC can be connected (one-
touch connection) using NFC.

1 Attach an IFU-WLMa3 to the camcorder
(page 48), and set Wi-Fi >Wi-Fi
(page 86) in the System menu to
“Enable” to enable wireless LAN.

N appears on the screen.

-

2 Open “Settings” on the device, select
“More,” and place a check mark in the
NFC checkbox.

The various settings will vary depending on
the device. For details, refer to the instruction
manual for the device.

3 Touch the camcorder using the device.

The device connects to the camcorder,
launches a web browser, and displays the
Wi-Fi remote control. Authentication is
required the first time that the device
connects.

* Some devices with a @ mark support NFC. For
details, refer to the operation manual for the device.

* Disable sleep mode and screen lock beforehand.

» Touch and hold the device still until the “Content
Browser Mobile” application launches (1 to
2 seconds).



Displaying the Wi-Fi
Remote Control

The Wi-Fi Remote screen is automatically
resized to match the screen size of the connected
device.

1 Connect the camcorder and device
using a Wireless LAN connection
(page 49).

2 Launch a browser on the device and
enter “http://<IP address of camcorder
(Wi-Fi >IP Adrress in System menu)>/
rm.htm]” in the URL bar.

For example, if the IP address is 192.168.1.1,
enter “http://192.168.1.1/rm.html” in the
URL bar.

3 Enter the user name and password
(Basic Authentication >User Name and
Password in the System menu).

When connection is successful, the Wi-Fi
Remote screen appears on the device.

You use the Wi-Fi Remote screen to operate
the camcorder.

You can disable the record button operation
by sliding the Lock knob to the right.

To display the page for a smartphone, change
“rm.html” to “rms.html” in the URL. To display the
page for a tablet, change “rm.html” to “rmt.html” in
the URL. When “rm.html” is entered, the page
automatically switches for display on the
corresponding device. However, the appropriate page
may not be displayed, depending on the device.

The Wi-Fi Remote screen may not match the

camcorder settings under the following circumstances.

If this occurs, reload the browser window.
- If the camcorder is restarted while connected
- If the camcorder is operated directly while
connected
- If the device has been reconnected
- If the browser Forward/Back buttons have been
used
The Wi-Fi remote control may not function if the
wireless signal strength becomes weak.
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Thumbnail Screen

Thumbnail Screen

The thumbnail screen appears if you press the THUMBNAIL button (page 9). The thumbnail screen
displays the clips stored on XQD memory cards as thumbnails (index pictures).

You can select a clip on the thumbnail screen and start playback of that clip. The playback image can be
displayed in the viewfinder and on an external monitor.

Pressing the THUMBNAIL button again closes the thumbnail screen and returns to the camera image.

Only the clips recorded in the currently selected recording format are displayed on the thumbnail screen. If an expected
recorded clip is not displayed, check the recording format. Take special note of this fact before formatting (initializing)
media.

Screen Layout
Information for the clip at the cursor position is displayed at the bottom of the screen.
Currently selected XQD memory card indicator

(A lock icon is displayed if the card is protected.)

Clip number/Total number of clips

o

(yellow) 1
TCR00:00:00:12 TCR00:00:00:15 TCR 00:00:00:34
4
it B

TCR 00:00:0i:56 TCR00:00:02:02 TCR00:00:02:35

1 : _ b
TCR00:00:04:45 TCR00:00:04:57  TCR 00:00:05:21

s Clin0006)] ( }—6

( | ) ( | ) (( | )
3 4 5
1. Thumbnail (index picture) 2. Clip name
Displays the index picture of a clip. When a clip Displays the name of the selected clip.

is recorded, its first frame is automatically set as
the index picture.

Clip/frame information is displayed below the
thumbnail. You change the information
displayed using Customize View (page 78)
>Thumbnail Caption in the Thumbnail menu.

3. Recording video format
Displays the file format of the selected clip.
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4. Special recording information
Displays the recording mode only if the clip was
recorded using a special recording mode.
For Slow & Quick Motion clips, the frame rate
is displayed on the right.

5. Clip duration

6. Creation date
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Playing Clips

Playing Recorded Clips

You can play recorded clips when the camcorder
is in recording standby (Stby) mode.

1 Insertan XQD memory card for
playback.

2 Press the THUMBNAIL button.

3 Turn the SEL/SET dial (page 9) to move
the cursor to the thumbnail for the clip
you want to play.

4  Press the SEL/SET dial.

Playback begins from the start of the selected
clip.

You can control playback by pressing the
following buttons.
SEL/SET dial:
Pauses playback.
Press again to return to normal playback.
Press left/right buttons:
Jumps to start of clip/start of next clip.
Press and hold left/right buttons:
Fast reverse/forward.
Returns to normal playback when you release
the button.
CANCEL/BACK button:
Stops playback, and returns to recording
standby mode.

There may be momentary picture breakup or still
image display at the boundary between clips. You
cannot operate the camcorder during this period.
When you select a clip in the thumbnail screen and
begin playback, there may be momentary picture
breakup at the start of the clip. To view the start of the
clip without breakup, put the camcorder into playback
mode, pause, then use the left button of the SEL/SET
dial to return to the start of the clip, and start playback
again.

You can also control playback using the supplied
remote control.



Clip Operations

On the thumbnail screen, you can operate the
clips or check clip properties using the thumbnail
menu.

The thumbnail menu (page 78) appears when you
press the MENU button and select a thumbnail.

Thumbnail Menu Operations

Turn the SEL/SET dial (page 9) to select a
function, then press the SEL/SET dial.

Press the CANCEL/BACK button (page 9) to
return to the previous screen.

Some items cannot be selected, depending on the state
when the menu was displayed.

Thumbnail menu items

Display Clip Properties

Set Index Picture

Thumbnail View

Set Shot Mark

Set Clip Flag

Lock/Unlock Clip

Delete Clip

Filter Clips

Customize View

For details about clip operation menus, see
“Thumbnail Menu” (page 78).

Displaying clip properties

Select Display Clip Properties (page 78) in the
Thumbnail menu to display the clip properties
screen.

Displaying the essence mark thumbnail
screen

Select Thumbnail View (page 78) >Essence
Mark Thumbnail in the Thumbnail menu and
select the essence mark type to display a
thumbnail view of the frames that have the
specified essence mark.
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Displaying the filtered clip thumbnail
screen

Select Filter Clips (page 78) in the Thumbnail
menu and select a clip flag type to display only
those clips that have the specified flag.

Deleting clips

You can delete clips from XQD memory cards.
Select Delete Clip >Select Clip or All Clips in the
Thumbnail menu.

Select Clip:
Deletes the selected clip. Multiple clip
selection is supported.

All Clips:
Deletes all of the displayed clips.

Changing the information displayed on
the thumbnail screen

You can change the clip/frame information
displayed below the thumbnail.

Select Customize View >Thumbnail Caption in
the Thumbnail menu and select the information to
display.

Date Time:

Displays the date and time the clip was
created and last modified.

Time Code:
Displays the timecode.

Duration:
Displays the duration of the clip.

Sequential Number:
Displays a sequential number on each
thumbnail.



Menu Display and Settings

Setup Menu Configuration and Hierarchy

Press the MENU button to display the setup menu
in the viewfinder to specify various items for
shooting, recording, and playback (menu can also
be displayed on an external monitor). The setup
menu comprises the following menus.

User menu:
Contains menu items configured by the user
using Edit User Menu.

Edit User menu:
Contains menu items for editing the User
menu.

Camera menu:
Contains settings related to shooting.

Paint menu:
Contains settings related to image quality.

Audio menu:
Contains settings related to audio.

Video menu:
Contains settings related to video output.

VF menu:
Contains settings to the viewfinder display.

TC/UB menu:
Contains settings related to timecode and
user bits.

Recording menu:
Contains settings related to recording.

Thumbnail menu:
Contains settings related to thumbnail
display.

Media menu:

Contains settings related to media.

File menu:
Contains settings related to files.

System menu:
Contains settings related to the system.
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Setup Menu Organization

User
(Factory settings)

Country

Base Setting

Rec Format

Codec

S&Q Motion

Picture Cache Rec

Simul Rec

Output Format

Monitor LUT

Clip

VF Setting

Assignable Button

Assignable Dial

Format Media

Edit User Menu

Edit User

Add Item

Customize Reset

Camera

ISO/Gain/EIl

Auto Exposure

Focus

Shutter

Color Bars

Noise Suppression

Flicker Reduce

SteadyShot

Handle Zoom

Auto Black Balance

AF Micro Adjustment

Video Light Set

Paint

White

Offset White

Black

Gamma

Black Gamma

Knee

White Clip

Detail(HD Mode)

Skin Detail

Aperture

Matrix

Multi Matrix

Maintenance

Audio

Audio Input

Audio Output




Video

Output On/Off System

Base Setting

Output Format Codec
Output Setting Rec Format
Monitor LUT Genlock
Output Display Assignable Button
VF VF Setting Assignable Dial
Peaking Rec Lamp
Zebra Fan Control
Marker HOLD Switch Setting
Display On/Off Lens
TC/UB Timecode Language
TC Display Clock Set
Users Bit Country
HDMI TC Out Hours Meter
Recording S&Q Motion Basic Authentication
Picture Cache Rec Wi-Fi
Simul Rec GPS
SDI/HDMI Rec Control IR Remote
Thumbnail Display Clip Properties Camera Battery Alarm
Set Index Picture Camera DC IN Alarm
Thumbnail View Ext. Unit Battery Alarm
Set Shot Mark Ext. Unit DC IN Alarm
Set Clip Flag All Reset
Lock/Unlock Clip APR
Delete Clip Camera Config
Filter Clips Version
Customize View
Media Update Media
Format Media
Clip
File All File
Scene File

User Menu Item

User Gamma

Monitor LUT

Monitor 3D LUT

Lens File
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Setup Menu Operations

Press the MENU button to display the setup menu
in the viewfinder to specify various items for
shooting, recording, and playback (menu can also
be displayed on an external monitor).

Menu controls

MENU button (page 9)
Turns menu mode for setup menu operations on/
off.

Left button/Right button (page 9) and SEL/SET
dial (page 9)

Press the left/right button to move the cursor left/
right to select menu items or settings.

Turn the SEL/SET dial to move the cursor up/
down to select menu items or settings.

Press the SEL/SET dial to apply the selected item.

CANCEL/BACK button (page 9)
Cancels a setting before it is applied, and moves
one level up in the menu hierarchy.

The setup menu cannot be operated when in focus
magnifier mode (page 37).

Setting menu items

Turn the SEL/SET dial to move the cursor to the
menu item to set, then press the SET/SEL dial to
select the item.

* The menu item selection area displays up to
eight lines. If the available options for an item
cannot be displayed at the same time, scroll the
display by moving the cursor up/down.
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« If an item has a large range of available options
(Example: —99 to +99), the selection area is not
displayed. The current setting is highlighted to
indicate that the value can be changed.

* Selecting [Execute] for a function will execute
the corresponding function.

* Selecting an item that requires confirmation
before execution will temporarily hide the menu
and display a confirmation message. Check the
message, and then select whether to execute or
cancel the function.

Entering a character string

When you select an item, such as a file name,
which requires character entry, the character
entry screen appears.

1

Edit File Name

Kurokawa_Scene_001 a

1 Turn the SEL/SET dial to select a
character type, the press the dial.

ABC: Uppercase alphabetic characters
abc: Lowercase alphabetic characters
123: Numeric characters

1#$: Special characters

2 Select a character from the selected
character type, then press the dial.

The cursor moves to the next field.

Space: Enters a space character at the cursor
position.

<«—/— : Moves the position of the cursor.
BS: Deletes the character on the left of the
cursor (backspace).

3 When finished, select [Done] and press
the dial.

The character string is confirmed and the
character entry screen disappears.



Setup Menu List

This section describes the function and settings of the items in each menu.
Factory default settings are shown in bold (for example, 18dB ).

User Menu
Item Sub-item setting Description
Country See Country in the System menu.

Region settings

Base Setting

See Base Setting in the System

Base settings menu.

Rec Format See Rec Format in the System
Recording format settings menu.

Codec See Codec in the System menu.
Codec settings

S$&Q Motion See S&Q Motion in the Recording
Slow & Quick Motion mode menu.

settings

Picture Cache Rec
Picture cache recording mode
settings

See Picture Cache Rec in the
Recording menu.

Simul Rec
Simultaneous recording settings

See Simul Rec in the Recording
menu.

Output Format

See Output Format in the Video

Output format settings menu.

Monitor LUT See Monitor LUT in the Video
Monitor LUT settings menu.

Clip See Clip in the Media menu.
Settings related to clip names

VF Setting See VF Setting in the VF menu.

Viewfinder settings

Assignable Button
Settings for assigning functions to
assignable buttons

See Assignable Button in the
System menu.

Assignable Dial
Settings for assigning functions to
assignable dials

See Assignable Dial in the System
menu.

Format Media

See Format Media in the Media

Format (initializes) memory cards menu.

Edit User Menu
Edit the User menu items

Edits the items in the User menu.

‘When “Edit User Menu” is selected, the Edit
User menu moves to the top level, and the
menu items are displayed.
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Edit User Menu

The Edit User menu is displayed at the top level when “Edit User Menu” is selected in the User menu.

Item Sub-item setting

Description

Add Item

Add an item to the User menu

Adds a menu item to the User menu.

Customize Reset
Reset the items in the User menu

Restores the menu items registered in the User
menu to the factory default.

Menu item selected during editing Delete

Deletes the registered menu item from the User
menu.

Move

Rearranges the registered menu items within
the User menu.

Edit Sub Item

Deletes the registered menu sub-item in the
User menu.

Camera Menu

Camera

Item Sub-item setting Description

ISO/Gain/El Mode Selects the gain setting mode.

Gain settings ISO/dB
ISO/Gain<H> Sets the <H> gain preset value.
When Mode is set to ISO and When Mode is set to ISO and dynamic range is 1300%
dynamic range is 460%. (Gamma Category is set to S-Log3).

I1SO 800 /ISO 1000 /
ISO 1250 /1SO 1600 /
1SO 2000 / ISO 2500 /
1ISO 3200 / ISO 4000 /
ISO 5000 / ISO 6400
When Mode is set to ISO and
dynamic range is 800%.
ISO 1600 / ISO 2000 /
1SO 2500/ ISO 3200 /
1SO 4000 / ISO 5000 /
ISO 6400 / ISO 8000 /
ISO 10000 / ISO 12500

ISO 2000 / ISO 2500 / ISO 3200/
ISO 4000 / ISO 5000 / ISO 6400 /
1SO 8000 / ISO 10000 / ISO 12500 /
ISO 16000

When Mode is set to dB.
-3dB/0dB /3dB /6dB /
9dB /12dB / 18dB

ISO/Gain<M>
(Same settings as ISO/
Gain<H>)

Sets the <M> gain preset value.

ISO/Gain<L>
(Same settings as ISO/
Gain<H>)

Sets the <> gain preset value.
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Camera

Item Sub-item setting

Description

Exposure Index<H>
500EI/ 4.0E
640El/ 4.3E
800EL/4.7E
1000EI/ 5.0E
1250EI/5.3E
1600EI/ 5.7E
2000EI/ 6.0E
2500EI/ 6.3E
3200El / 6.7E
4000EL/ 7.0E
5000EIL/7.3E
6400EL/7.7E
8000EI / 8.0E

Sets the <H> exposure index value.
Available in Cine EI mode only.

Exposure Index<M>
(Same settings as Exposure
Index<H>)

Sets the <M> exposure index value.

Exposure Index<L>
(Same settings as Exposure

Sets the <> exposure index value.

Index<H>)
Shockless Gain Turns the shockless gain function on/off.
On/Off
Auto Exposure Level Sets the brightness level for the automatically detected
Automatic -2.0/-1.75/-15/-1.25/ exposure.
exposure -1.0/-0.75/-0.5/-0.25/0/
adjustment +0.25/+0.5/+0.75/+1.0/
settings +1.25/+1.5/+1.75/+42.0
Mode Sets the control mode.
Backlight / Standard / Backlight:
Spotlight Backlight mode (mode for reduced darkening of a subject
when the subject is backlit)
Standard:
Standard mode
Spotlight:
Spotlight mode (mode for reduced clipped whites when
subject is lit by spotlighting)
Speed Sets the adjustment speed.
-99 to +99 (x0)
AGC Turns the AGC (auto gain control) function on/off.
On / Off
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Camera

Item

Sub-item setting

Description

AGC Limit

When ISO/Gain/EIl >Mode is set to

dB.
3dB/6dB/9dB/ 12dB/
15dB / 18dB

When ISO/Gain/EI >Mode is set to

ISO and dynamic range is 460%.
1SO1000/1SO1600/1SO2000/
1S0O3200 / 1ISO4000 / ISO6400

When ISO/Gain/EIl >Mode is set to

ISO and dynamic range is 800%.
1S0O2000 /1SO3200/1SO4000 /
1S06400 / 1ISO8000 /
1SO12500

When ISO/Gain/EI >Mode is set to

ISO and dynamic range is 1300%.
1S0O2500 / 1SO4000/ ISO5000 /
1SO8000 / 1ISO10000 /
1SO16000

Sets the maximum gain of the AGC function.

Auto Shutter
On / Off

Turns the auto shutter control function on/off.

A.SHT Limit
1/100/ 1/150 / 17200 /
1/250/1/2000

Sets the fastest shutter speed of the auto shutter function.

Clip High light
On / Off

Turns the function that ignores brightest areas to provide a
flatter reaction to high luminance on/off.

Detect Window
1/2/3/4/5/6

Sets the light meter range for automatically adjusting the
exposure according to the brightness of the subject. (Not
available when adjusting exposure manually)

Detect Window Indication
On / Off

Turns the Detect Window function on/off.

Focus
Focus settings

AF Assist
On / Off

When set to On, allows you to temporarily override auto focus
and set focus manually.
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Camera

Item Sub-item setting Description

Shutter Mode
Speed / Angle / ECS / Off

Selects the operating mode of the electronic shutter.
Speed/Angle (standard mode):
Used for shooting fast-moving subjects clearly. Selects the
mode for setting the shutter speed in seconds (Speed) or as
a shutter angle (Angle).
ECS (Extended Clear Scan):
Used for shooting without scrolling horizontal bars
appearing in the viewfinder.

Electronic shutter
operating
condition settings

Shutter Speed
1/3 to 1/9000

Sets the shutter speed when Mode is set to Speed. The
available settings vary depending on the frame frequency of
the selected video format.

Shutter Angle
5.625°/11.25°/22.5°/45°/
90°/120° / 144°/ 150° /

Sets the shutter angle when Mode is set to Angle.

172.8°/180°/216° / 300°
ECS Frequency Sets the ECS frequency when Mode is set to ECS. The
23.99 to 8000 (60) available settings vary depending on the frame frequency of
the selected video format.
Color Bars Setting Turns the color bars on/off.
Color bar settings On / Off
Type Selects the color bar type.

ARIB / SMPTE / 75% / 100%

Noise Setting Turns the noise suppression function on/off.
Suppression On/ Off (Enabled when Base Setting >Shooting Mode in the System
Noise suppression menu is set to Custom)
settings Level Sets the noise suppression level.
Low / Mid / High
Flicker Reduce Mode Sets the flicker correction mode.
Flicker correction Auto / On / Off
settings Frequency Sets the frequency of the power source supplying the lighting
50Hz / 60Hz that is causing the flicker.
SteadyShot Setting Turns the image stabilization function on/off.
Image stabilization ~ Active SteadyShot / m
settings SteadyShot / Off

Enabled when a compatible lens is attached.

Handle Zoom

Zoom Speed Type

Sets the mode of the zoom lever on the handle.

Handle zoom Fix / Variable / Off
settings m
Disabled when the handle is not attached.
Zoom Speed Sets the speed of the handle zoom.
1to8(3) (Enabled when Zoom Speed Type is set to Fix)
Disabled when the handle is not attached.
Auto Black Auto Black Balance Runs the auto black balance function.
Balance Execute / Cancel
Auto black m

balance settings

¢ The auto black balance function cannot be run if the iris is not
closed. Attach the lens cap and then execute.

 Cannot be run during recording or color bar display.

¢ Cannot be run when in Interval Rec mode, Frame Rec mode,
Slow & Quick Motion mode, or Slow Shutter mode.
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Camera

Item Sub-item setting Description

AF Micro Setting Turns the auto focus micro adjustment function on/off.
Adjustment On / Off

Focus position Amount Sets the auto focus micro adjustment level.

micro adjustment -20 to 0 to +20 Use the following procedure to adjust A-mount lenses.
(Enabled when 1 Attach the lens you want to adjust using an LA-EA2/4
LA-EA2/4

(option) is used)

(option).

2 Set Setting to On, and adjust the Amount value.
Positive values move the focus behind the subject, and
negative values move the focus in front of the subject.
It is recommended that you check the result using one-push
AF, for example, while adjusting the focus.

Clear All
Execute / Cancel

Initializes the saved adjustment values.

Video Light Video Light Set

Set Power Link / Rec Link / Rec

Video light Link + Stby
settings (when

using HVL-LBPC

(option))

Sets the lighting control method for the video light attached to
the multi-interface shoe.
Power Link:
Turns the video light on/off when the camcorder is turned
on/off.
Rec Link:
Turns the video light on/off when the camcorder starts/
stops recording.
Rec Link + Stby:
Turns the video light on/off when the camcorder is
recording or in standby mode.
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Paint Menu

Item Sub-item setting Description

White Color Temp<A> Displays the white balance color temperature saved in

White balance 1500K to 50000K (3200K) memory A.

settings Color Temp. Balance<A> Sets the white balance gain value saved in memory A (linked

—99 to +99 (x0)

to R gain and B gain).

R Gain<A> Sets the white balance R gain value saved in memory A.
-99 to +99 (20)

B Gain<A> Sets the white balance B gain value saved in memory A.
-99 to +99 (x0)

Color Temp<B> Displays the white balance color temperature saved in
1500K to 50000K (3200K) memory B.

Color Temp. Balance<B>
-99 to +99 (x0)

Sets the white balance gain values saved in memory B (linked
R gain and B gain).

R Gain<B> Sets the white balance R gain value saved in memory B.
-99 to +99 (+0)
B Gain<B> Sets the white balance B gain value saved in memory B.
-99 to +99 (20)
Filter White Memory Turns the function that sets the white balance memory area for
On / Off each ND filter on/off.
On: Sets the white balance memory for each ND filter.
Off: Sets white balance memory common to all ND filters.
Shockless White Sets the white balance response speed when switching white
Off /1/2/3 balance mode.
Off: Switches instantaneously.
1 to 3: Switches more slowly the higher the number.
White Switch <B> Selects the white balance adjustment mode that is selected
Memory / ATW when the WHT BAL switch is set to B.
ATW Speed Sets the response speed in ATW mode.
1/2/3/4/5 1: Fastest response speed
Color Temp<P> Sets the white balance preset value.
1500K to 50000K (3200K)
C.Temp BAL <P> Sets more precise color temperature settings, for use when
-99 to +99 (x0) satisfactory video cannot be obtained with Color Temp <P>.
R Gain <P> Specifies the R gain preset value.
-99 to +99 (x0)
B Gain <P> Specifies the B gain preset value.
-99 to +99 (x0)
AWB Enable<P> Turns execution of auto white balance on/off when the WHT
On / Off BAL switch is set to PRESET.
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Item Sub-item setting Description
Offset White  Offset White<A> Selects whether to add (On) or not to add (Off) an offset value
White balance On / Off to the white balance in memory A.

offset settings

Warm Cool <A>
-99 to +99 (x0)

Sets the offset added to the white balance in memory A as a
color temperature when Offset White<A> is set to “On.”

Warm Cool Balance<A>

Sets a more precise color temperature, for use when a

-99 to +99 (+0) satisfactory image cannot be obtained using Warm Cool <A>.
Offset White<B> Selects whether to add (On) or not to add (Off) an offset value
On / Off to the white balance in memory B.
Warm Cool <B> Sets the offset added to the white balance in memory B as a
-99 to +99 (+0) color temperature when Offset White<B> is set to “On.”

‘Warm Cool Balance<B>
-99 to +99 (+0)

Sets a more precise color temperature, for use when a
satisfactory image cannot be obtained using Warm Cool <B>.

Offset White<ATW> Selects whether to add (On) or not to add (Off) an offset value
On / Off to the ATW white balance.

Warm Cool <ATW> Sets the offset added to the ATW white balance as a color
-99 to +99 (x0) temperature when Offset White<ATW> is set to “On.”

Warm Cool Balance<ATW> Sets a more precise color temperature, for use when a

—99 to +99 (x0)

satisfactory image cannot be obtained using Warm Cool
<ATW>.

Black Setting Turns black correction on/off.
Black settings On/ Off
Master Black Sets the master black level.

—99 to +99 (x0)

Fine adjustment is supported by turning the SEL/SET dial
slowly. In this case, the displayed value may not change.

R Black Sets the R black level.
-99 to +99 (x0)
B Black Sets the B black level.

-99 to +99 (x0)
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Item Sub-item setting Description
Gamma Setting Turns the gamma correction function on/off.
Gamma correction On/ Off
settings Step Gamma Sets a gamma correction value in 0.05 steps.
0.35 to 0.45 to 0.90
Master Gamma Sets the master gamma level.
—99 to +99 (x0)
R Gamma Sets the R gamma level.
—99 to +99 (x0)
G Gamma Sets the G gamma level.
-99 to +99 (x0)

Gamma Category
STD /HG/ User / S-Log3

Selects use of standard gamma (STD), HyperGamma (HG),
user gamma (User), or S-Log3.

Gamma Select
When Gamma Category is set to
STD.
STD1 DVW /STD2x 4.5/
STD3 x 3.5/ STD4 240M /
STD5 R709 / STD6 x 5.0
When Gamma Category is set to
HG.
HGI1 3250G36 / HG2 4600G30
/ HG3 3259G40 / HG4
4609G33 / HG7 8009G40 /
HGS8 8009G33
When Gamma Category is set to
User.
User 1/ User 2/ User 3/ User 4
/ User 5
When Gamma Category is set to

Selects the gamma table used for gamma correction.

S-Log3.
S-Log3
Black Gamma Setting Turns the black gamma correction function on/off.
On / Off m
The Black Gamma and Knee >Knee Saturation functions
cannot be used at the same time.
Range Selects the effective range of the black gamma correction.

Low / Mid / High

Master Black Gamma
-99 to +99 (x0)

Sets the master black gamma level.
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Item Sub-item setting Description
Knee Setting Turns the knee correction function on/off.
On / Off (Enabled when Gamma >Gamma Category is set to STD)
Auto Knee Turns the auto knee correction function on/off.
On / Off
Point Sets the knee point.
75% to 109% (90%)
Slope Sets the knee slope.
-99 to +99 (x0)
Knee Saturation Enables/disables knee saturation adjustment (adjusts coloring
On / Off above the knee point).
The Black Gamma and Knee >Knee Saturation functions
cannot be used at the same time.
Knee Saturation Level Sets the level for adjusting the coloring above the knee point
-99 to +99 (x0) (knee saturation).
White Clip Setting Turns the white clip adjustment function on/off.
White clip On / Off
adjlllstment Level Sets the white clip level.
settings When Country is not set to PAL

Area.
90.0% to 109.0% (108.0%)
When Country is set to PAL Area.
90.0% to 109.0% (105.0%)
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Item Sub-item setting Description
Detail Setting Turns the detail adjustment function on/off.
Detail adjustment On / Off
settings Level Sets the detail level.
-99 to +99 (x0)
H/V Ratio Sets the mix ratio between the H detail level and the V detail
-99 to +99 (x0) level.
Crispening Sets the crispening level.
—99 to +99 (x0)
Level Depend Turns the level dependence adjustment function on/off.
On / Off

Level Depend Level
-99 to +99 (20)

Sets the level dependence level.

Frequency
-99 to +99 (x0)

Sets the center frequency of the detail (detail thickness).
The detail is thinner the higher the center frequency, and
thicker the lower the center frequency.

Knee Aperture

On / Off

Turns the knee aperture correction function on/off.

Knee Aperture Level
—-99 to +99 (x0)

Sets the knee aperture level.

Limit Sets the detail limiter for both the white-side and black-side
-99 to +99 (x0) directions.

White Limit Sets the white-side detail limiter.
-99 to +99 (x0)

Black Limit Sets the black-side detail limiter.
-99 to +99 (x0)

V Black Limit Sets the black-side V detail limiter.

—99 to +99 (x0)

V Detail Creation

Sets the signal source for creating the V detail to NAM (G or

NAM/Y/G/G+R R, whichever is higher), Y, G, or G+R.
Skin Detail Setting Turns the skin detail correction function on/off.
Skin detail On / Off

correction settings

Area Detection
Execute / Cancel

Detects the color used for skin detail correction.
Execute: Run detection

Area Indication

Turns the function that displays zebra in areas of the color

On/ Off used for skin detail correction on/off.
Level Sets the skin detail level.
—99 to +99 (x0)
Saturation Sets the saturation of the color targeted for skin detail
-99 to +99 (x0) correction.
Hue Sets the hue of the color targeted for skin detail correction.
0 to 359
Width Sets the range for the hue of the color targeted for skin detail
0 to 90 (40) correction.
Aperture Setting Enables/disables aperture correction (processing that
Aperture On / Off improves resolution by adding a high-frequency aperture
correction settings signal to the video signal to correct deterioration due to high-
frequency characteristics).
Level Sets the aperture correction level.

-99 to +99 (20)
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Item Sub-item setting Description
Matrix Setting Turns the matrix correction function on/off.
Matrix correction On / Off
settings Adaptive Matrix Turns the adaptive matrix function on/off.
On / Off
Preset Matrix Turns the preset matrix function on/off.
On / Off
Preset Select Selects a preset matrix.
Standard
High Saturation
FL Light
Cinema
F55709 Like
User Matrix Turns the user matrix correction function on/off.
On/ Off
Level Adjusts the color saturation of the entire image.
-99 to +99 (x0)
Phase Adjusts the color tone (phase) of the entire image.

—99 to +99 (x0)

User Matrix R-G
-99 to +99 (x0)

Sets a user-defined R-G user matrix.

User Matrix R-B
—99 to +99 (x0)

Sets a user-defined R-B user matrix.

User Matrix G-R
-99 to +99 (x0)

Sets a user-defined G-R user matrix.

User Matrix G-B
—99 to +99 (x0)

Sets a user-defined G-B user matrix.

User Matrix B-R
-99 to +99 (x0)

Sets a user-defined B-R user matrix.

User Matrix B-G
-99 to +99 (x0)

Sets a user-defined B-G user matrix.

Multi Matrix

Multi matrix

correction settings

Setting Turns the multi matrix correction function on/off.
On / Off

Area Indication Turns the area indication function on/off.
On / Off

Color Detection
Execute / Cancel

Detects the color used for multi matrix correction.

Axis

Selects the axis.

B /B+/MG-/MG/MG+/
R/R+/YL-/YL/YL+/G-/

G/G+/CY/CY+/B-

Hue Sets the hue of the color used for multi matrix correction.
-99 to +99 (x0)

Saturation Sets the saturation of the color used for multi matrix

-99 to +99 (x0) correction.

Maintenance  Test Saw
On/ Off

Turns the test signal on/off.
Maintenance
settings
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Audio Menu

Item Sub-item setting Description
Audio Input CHI1 Input Select Switches the input source for recording on channel 1.
Audio input INPUT!1 / Internal MIC /
settings Shoe 1
CH2 Input Select Switches the input source for recording on channel 2.

INPUTI1 / INPUT2 /
Internal MIC / Shoe 2

INPUT1 Reference
—60dB / —-50dB / -40dB

Sets the reference recording level for XLR microphone input
from INPUT1.

INPUT?2 Reference Sets the reference recording level for XLR microphone input
—60dB / -50dB / -40dB from INPUT?2.
Audio Input Level Sets the audio input level.
0to +99
CHI1 Wind Filter Enables/disables the wind reduction filter for channel 1
On / Off recording.
CH2 Wind Filter Enables/disables the wind reduction filter for channel 2
On / Off recording.
Limiter Mode Selects the limiter characteristic for large input signals when
Off / —6dB / -9dB / -12dB / adjusting the audio input level manually.
-15dB /-17dB
AGC Mode Sets the auto level adjustment mode.
Mono / Stereo
AGC Spec Selects the AGC characteristic.
—-6dB /-9dB /-12dB /
-15dB /-17dB
1kHz Tone on Color Bars Turns the 1 kHz reference tone signal on/off when displaying
On / Off color bars.
CHI Level Sets the combination of audio input level adjustments enabled
Audio Input Level / Side / for recording channel 1.
Lvi+Side
CH2 Level Sets the combination of audio input level adjustments enabled
Audio Input Level / Side / for recording channel 2.
Lvi+Side
Audio Output Monitor CH Selects the audio channel output to the headphone connector
Audio output MIX /CH1/CH2 and built-in speaker.
settings Monitor Volume Adjusts the monitor audio level output to the headphone
0to 15(7) connector and built-in speaker.
Headphone Out Selects whether the headphone connector output is monaural
Mono / Stereo (Mono) or stereo (Stereo).

Alarm Volume
0to7(4)

Adjusts the volume of the alarm.

Output Limiter
On / Off

Turns the audio output limiter on/off.
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Video Menu

Item Sub-item setting

Description

Output On/Off SDI

Turns SDI output on/off.

Video output On/ Off
settings HDMI Turns HDMI output on/off.
On / Off

Output Format SDI

Output format HDMI
settings

Sets the SDI and HDMI output resolution.
For details about settings, see “Video Formats and Output
Signals” (page 94).

Output Setting HDMI Target Device
Output conversion Recorder / Monitor
mode settings

Sets the type of HDMI input device connected to the HDMI
output.
Recorder:
Applies the SDI1 MLUT settings when in Cine EI mode.
Monitor:
Applies the SDI2 MLUT and Output Display settings when
in Cine EI mode.

4K/2K to HD Conv.
Edge Crop / Letter Box

Sets the 17:9 to 16:9 video output conversion mode.
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Item Sub-item setting

Description

Monitor LUT  Category

Monitor LUT LUT / Look Profile / User 3D
settings LUT

Available in Cine

EI mode only.

Sets the type of Look applied as a monitor LUT.

LUT:
Outputs video with applied preset LUT or user LUT.

Look Profile:
Outputs video close to print film or video which is suitable
as the start point of color grading, by selecting a Look
number.

User 3D LUT:
Outputs video with applied user 3D LUT.

LUT Select
P1: 709(800%)
P2: HG8009G40
P3: HG8009G33

Selects the LUT type, when Monitor LUT >Category is set to
LUT.
709(800%):

Signal with ITU-R709 base curve with extended dynamic

P5: S-Log3 range up to 800%.
Ul HG8009G40:
U2 Signal using HyperGamma with 800% dynamic range,
u3 109% white limit, and 18% gray card video output of 40%.
u4 HG8009G33:
us Signal using HyperGamma with 800% dynamic range,
U6 109% white limit, and 18% gray card video output of 33%.
S-Log3:
Log signal with 1300% dynamic range that mimics film
characteristics, close to Cineon Log curve.
(Enabled when Base Setting >Color Space in the System
menu is set to SGamut3.Cine/SLog3)
Ul to U6:
User LUT signals imported from an SD card.
Look Profile Select Selects the type of Look profile, when Monitor LUT
1: LC-709 >Category is set to Look Profile.
2: LC-709typeA
3: SLog2-709
4: Cine+709
User 3D LUT Select Selects the type of user 3D LUT.
User 3D-1
User 3D-2
User 3D-3
User 3D-4
SDI1 & Internal Rec Selects whether to apply monitor LUT to the SDI OUT1
MLUT On/ MLUT Off output video and the video recorded on XQD memory cards.
SDI2 Selects whether to apply monitor LUT to the SDI OUT2
MLUT On/ MLUT Off output video.
HDMI Displays whether monitor LUT is applied to the HDMI output
MLUT On/ MLUT Off video.
Viewfinder Selects whether to apply monitor LUT to the viewfinder
MLUT On/ MLUT Off output video.
Output Display SDI2 Selects whether to superimpose menus and status on the SDI
Output signal On / Off output signal and HDMI output signal.
settings HDMI
On / Off
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VF Menu

Item Sub-item setting Description
VF Setting Brightness Adjusts the brightness of the viewfinder image.
Viewfinder -99 to +99 (x0)
settings Color Mode Selects the display mode of the viewfinder in E-E/recording
Color /B&W mode.
Peaking Setting Turns the peaking function on/off.
Peaking settings On/ Off
Peaking Type Selects the peaking type.
Normal / Color Normal: Normal peaking
Color: Color peaking
Frequency Selects the peaking frequency.
Normal / High
Normal Peaking Level Sets the normal peaking level.
0to 99 (50)
Color Selects the color of the color peaking signal.
B&W /Red / Yellow / Blue
Color Peaking Level Sets the color peaking level.
0to 99 (50)
Zebra Setting Turns the Zebra function on/off.
Zebra pattern On / Off
settings Zebra Select Selects the zebra pattern type (Zebra 1, Zebra 2, Both).
1/2/Both
Zebral Level Sets the Zebra 1 display level.
50% to 107% (70%)
Zebral Aperture Level Sets the Zebra 1 aperture level.
1% to 20% (10%)
Zebra2 Level Sets the Zebra 2 display level.

52% to 109% (100%)
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Item Sub-item setting Description
Marker Setting Turns the display of all markers on/off.
Marker display On/ Off
settings Color Selects the marker signal color.
White / Yellow / Cyan / Green /
Magenta / Red / Blue
Center Marker Turns the center marker on/off.
1/2/3/470Off
Safety Zone Turns the safety zone marker on/off.
On/ Off
Safety Area Selects the size of the safety zone marker (as a percentage of
80% / 90% / 92.5% / 95% total screen size).
Aspect Marker Selects the type of aspect marker.
Line / Mask / Off
Aspect Mask Sets the level of the video signal outside the marker relative to
0to 15(12) the signal inside the marker as a percentage.
Aspect Safety Zone Turns the aspect safety zone marker on/off.
On / Off
Aspect Safety Area Selects the size of the aspect safety zone marker (as a
80% /90% / 92.5% / 95% percentage of total screen size).
Aspect Select Sets the mode when displaying the aspect marker.
4:3/1.66:1/
1.85:1/2.35:1/2.4:1
User Box Turns the box cursor display on/off.
On / Off
User Box Width Sets the box cursor width (distance from the center to the left
3 to 479 (240) and right edges).
User Box Height Sets the box cursor height (distance from the center to the top
3 to 269 (135) and bottom edges).

User Box H Position
—476 to +476 (0)

Sets the horizontal position of the box cursor center.

User Box V Position

Sets the vertical position of the box cursor center.

—266 to +266 (0)

100% Marker Turns the 100% marker on/off.
On / Off

Guide Frame Turns the guide frame display on/off.
On/ Off
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Item Sub-item setting

Description

Display On/Off Setting
Display item On / Off

Selects the items to display in the viewfinder.

settings Shutter Setting
On/ Off

ND Filter Position
On/ Off

Gain Setting
On / Off

Rec/Play Status
On/ Off

HXR-IFRS5 Rec Control

On/ Off

Color Temp.
On / Off

Frame Rate
On/ Off

Battery Remain
On/ Off

Timecode
On/ Off

Audio Manual
On/ Off

Audio Level Meter
On/ Off

Media Status
On/ Off

Focus Position

Meter / Feet / Off

Iris Position
On / Off

Zoom Position

Number / Bar / Off

SteadyShot
On / Off

Focus Mode
On/ Off

Focus Area Indicator

On/ Off

Focus Indicator
On/ Off

Auto Shutter
On/ Off

AGC
On/ Off

Auto Iris
On/ Off

AE Mode
On / Off
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Item Sub-item setting Description

Auto Exposure Level
On/ Off

White Balance Mode
On/ Off

SDI/HDMI Rec Control
On/ Off

Rec Format
On/ Off

Gamma
On/ Off

Timecode Lock
On/ Off

Wi-Fi Condition
On/ Off

Video Signal Monitor
Off / Waveform / Vector /
Histogram

Clip Name
On / Off

Focus Assist Indicator
On/ Off

Focus Area Marker
On / Off

Video Level Warning
On/ Off

Clip Number
On / Off

GPS
On/ Off

Level Gauge
On / Off

Lens Info
Meter / Feet / Off

Notice Message
On/ Off
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TC/UB Menu

TC/UB

Item Sub-item setting

Description

Timecode Mode
Timecode settings Preset / Regen / Clock

Sets the timecode running mode.
Preset:
Starts running from a preset value.
Regen:
Starts running from the timecode of the end of the previous
clip.
Clock:
Uses the internal clock as the timecode.

Run
Rec Run / Free Run

Rec Run: Runs only when recording.
Free Run: Always running, regardless of camcorder operation.

Setting Sets the timecode to an arbitrary value.
SET: Set the value.
Reset Resets the timecode to 00:00:00:00.
Execute / Cancel Execute: Reset timecode
TC Format Sets the timecode format.
DF / NDF DF: Drop Frame

NDF: Non-Drop Frame

TC Display Display Select
Time data display Timecode / Users Bit /

Switches the time data display.

settings Duration
Users Bit Mode Sets the user bit mode.
Settings related to Fix / Time Fix: Uses an arbitrary fixed value in user bits.
user bits. Time: Uses the current date and time in user bits.
Setting Sets the user bits to an arbitrary value.
HDMI TC Out  Setting Sets whether to output the timecode to devices for other
On / Off purposes, using HDMIL.
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Recording Menu

Item Sub-item setting Description
S&Q Motion Setting Turns Slow & Quick Motion on/off.
Slow & Quick On / Off
Mo?ion mode High Frame Rate Mode Enables higher speed imaging than 60P.
settings Off / Full Scan Off:
Higher speed imaging than 60P is disabled.
Full Scan:
Enables high-speed imaging at Super 35 frame size.
Frame Rate Sets the frame rate for Slow & Quick Motion shooting
Up to 240fps (page 43).

The initial value varies depending on the Codec, Country,
Video Format, and RAW Output Format settings.

Picture Cache Setting

Turns the picture cache recording function on/off.

Rec On/ Off
Picture cache Cache Rec Time Sets the picture cache recording time, when Picture Cache Rec
recording mode 0-2sec / 2-4sec / 4-6sec / is set to On.
settings 6-8sec / 8-10sec /

10-12sec / 12-14sec /

13-15sec
Simul Rec Setting Turns the simultaneous recording function on/off and sets the
Simultaneous On/ Off recording destination media.

recording settings Rec Button Set
“Rec Button [SlotA SlotB]
Handle Rec Button [SlotA
SlotB]” / “Rec Button [SlotA]
Handle Rec Button [SlotB]” /
“Rec Button [SlotB] Handle
Rec Button [SlotA]”

Assigns the record buttons used to control each recording
media.

SDI/HDMI Rec  Setting
Control On/ Off
SDI/HDMI

recording control

settings

Turns recording start/stop control for an external connected
device, using SDI/HDMI signals, on/off.
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Thumbnail Menu

Thumbnail

Item

Sub-item setting

Description

Display Clip
Properties
Display clip
properties screen

Displays the clip properties screen.

Set Index
Picture

Clip index picture
settings

Sets the index picture of a clip.

Thumbnail Essence Mark Thumbnail Displays thumbnails of frames with essence marks.
View All / Rec Start / Shot Mark1 /
Thumbnail screen Shot Mark?2 / Shot Mark3 /
settings Shot Mark4 / Shot Mark5 /
Shot Mark6 / Shot Mark7 /
Shot Mark8 / Shot Mark9 /
Shot MarkO
Clip Thumbnail Displays thumbnails of recorded clips.
Set Shot Mark Add Shot Mark1 Adds Shot Mark .
Shot mark settings Delete Shot Mark 1 Deletes Shot Mark1.
Add Shot Mark2 Adds Shot Mark?2.
Delete Shot Mark2 Deletes Shot Mark?2.
Set Clip Flag Add OK Adds an OK flag.
Clip flag settings ~ Add NG Adds an NG flag.
Add KEEP Adds a Keep flag.
Delete Clip Flag Deletes all flags.
Lock/Unlock  Select Clip Selects and locks/unlocks a clip.
Clip Lock All Clips Locks all clips.
Clip protection  “r71 4 All Clips Unlocks all clips.
Delete Clip Select Clip Deletes the selected clip.
Delete clips All Clips Deletes all of the displayed clips.
Filter Clips OK Display only clips that have an OK flag.
Filtered clip NG Display only clips that have an NG flag.
ispl .
display settings KEEP Display only clips that have a Keep flag.
None Display only clips that have no flag.
Customize Thumbnail Caption Switches the information displayed below thumbnails.
View Date Time / Time Code /

Thumbnail screen
settings

Duration / Sequential Number
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Media Menu

Item Sub-item setting Description
Update Media Media (A) Updates the management file on the XQD memory card in slot
Update memory Execute / Cancel A.
cards Execute: Update card
Media (B) Updates the management file on the XQD memory card in slot

Execute / Cancel

B.
Execute: Update card

Format Media Media (A)
Format (initializes) Execute / Cancel

Initializes the XQD memory card in slot A.
Execute: Initialize card

memory cards Media (B) Initializes the XQD memory card in slot B.
Execute / Cancel Execute: Initialize card
SD Card Initializes the UTIILITY SD card.

Execute / Cancel

Execute: Initialize card

Clip Auto Naming
Clip name settings ~ Cam ID + Reel# / Title

Sets the method for naming clips.

Cam ID + Reel#:
Camera ID + Reel Number + Shot Number +
Date + randomized string

Title:
String set using Title Prefix + Clip Number

Camera ID Sets the camera ID when Auto Naming is set to Cam ID +
AtoZ Reel#.

Reel Number Sets the numeric part of Reel Number when Auto Naming is
001 to 999 set to Cam ID + Reel#.

Camera Position
C/L/R

Sets the Shot Number prefix when Auto Naming is set to Cam
ID + Reel#.

Title Prefix

Sets the title portion of the clip name when Auto Naming is
set to Title.

(Initial value is a model-specific ID, comprising the last three
digits of the serial number.)

(The value is entered using the character entry screen

(page 56).)

Number Set
0001 to 9999

Sets the numeric portion of the clip name when Auto Naming
is set to Title.
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File Menu

Item Sub-item setting Description
All File Load SD Card Loads an ALL file.
Settings related to Execute / Cancel Execute: Load file
ALL files. Save SD Card Saves an ALL file.
Execute / Cancel Execute: Save file
File ID Assigns a name to the file.
Scene File Recall Internal Memory Loads a scene file from internal memory.

Scene file settings

Execute / Cancel

Execute: Load file

Store Internal Memory
Execute / Cancel

Saves a scene file in internal memory.
Execute: Save file

Load SD Card
Execute / Cancel

Loads a scene file from an SD card.
Execute: Load file

Save SD Card
Execute / Cancel

Saves a scene file to an SD card.
Execute: Save file

File ID Assigns a name to the file.
Scene White Data Sets whether to apply the white balance data when loading
On/ Off scene files.
User Menu Load SD Card Loads User menu settings on an SD card into internal
Item Execute / Cancel memory.

User menu item
settings

Execute: Load settings

Save SD Card
Execute / Cancel

Saves User menu settings on an SD card.
Execute: Save settings

File ID

Displays the File ID specified for the file loaded using Load
SD Card. Also sets (edits) the File ID when saving a file using
this menu.

User Gamma
User gamma file
settings

Current Settings

Displays a list of the current user gamma file settings (file
names).

Load SD Card
Execute / Cancel

Loads user gamma settings on an SD card into internal
memory.
Execute: Load gamma

Reset
1/2/3/4/5/Al

Initial value: 709(800%)

Resets the user gamma files in internal memory to default
values.

1 to 5: Reset individual user gamma

All: Reset all user gammas

Monitor LUT
Monitor LUT file
settings

Current Settings

Displays a list of the current monitor LUT file settings (file
names).

Load SD Card
Execute / Cancel

Loads monitor LUT settings on an SD card into internal
memory.
Execute: Load LUT settings

Reset
1/2/3/4/5/6/Al

Resets the monitor LUT data in internal memory to default
values.

1 to 6: Reset individual monitor LUT

All: Reset all monitor LUTs
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Item Sub-item setting Description
Monitor 3D Current Settings Displays a list of the current monitor 3D LUT file settings (file
LUT names).
Monitor 3D LUT ' | 0ad SD Card Loads monitor 3D LUT settings on an SD card into internal
file settings Execute / Cancel memory.
Execute: Load 3D LUT settings
Reset Resets the monitor 3D LUT data in internal memory to default
1/2/3/4/A1 values.

1 to 4: Reset individual monitor 3D LUT
All: Reset all monitor 3D LUTSs

Lens File White Offset R Sets the white balance offset R channel correction value for
Lens file settings -99 to +99 (x0) the lens in the lens file.
White Offset B Sets the white balance offset B channel correction value for
-99 to +99 (x0) the lens in the lens file.
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System Menu

Item Sub-item setting

Description

Base Setting
Base settings

Shooting Mode
Custom / Cine EI

Sets the shooting mode.

Color Space
S-Gamut3.Cine/SLog3 /
S-Gamut3/SLog3 / Matrix

Sets the color space.

Select
RAW /RAW & XAVC-1/RAW
& XAVC-L / RAW & MPEG
HD 422 / XAVC-l / XAVC-L /
MPEG HD 422

Codec
Codec settings

Sets the recording/playback mode.

RAW, RAW & XAVC-I, RAW & XAVC-L, and RAW &
MPEG HD 422 are displayed when an XDCA-FS7 is
connected.

Rec Format Video Format

Recording format

settings * For NTSC systems:

When Codec >Select is set to

XAVC-1.
3840x2160 59.94P
3840x2160 29.97P
3840x2160 23.98P
1920x1080 59.94P
1920x1080 59.94i
1920x1080 29.97P
1920x1080 23.98P

When Codec >Select is set to

XAVC-L.
3840x2160 59.94P
3840x2160 29.97P
3840x2160 23.98P
1920x1080 59.94P 50
1920x1080 59.94P 35
1920x1080 59.94i 50
1920x1080 59.94i 35
1920x1080 59.94i 25
1920x1080 29.97P 50
1920x1080 29.97P 35
1920x1080 23.98P 50
1920x1080 23.98P 35

When Codec >Select is set to

MPEG HD422.
1920x1080 59.94i 50
1920x1080 29.97P 50
1920x1080 23.98P 50
1280720 59.94P 50
1280%720 29.97P 50
1280720 23.98P 50

Sets the recording format.

¢ For PAL systems:
When Codec >Select is set to XAVC-I.
3840%x2160 50P
3840x2160 25P
1920x1080 50P
1920x1080 50i
1920x1080 25P
When Codec >Select is set to XAVC-L.
3840%x2160 50P
3840x2160 25P
1920x1080 50P 50
1920x1080 50P 35
1920x1080 50i 50
1920x1080 50i 35
1920x1080 50i 25
1920x1080 25P 50
1920x1080 25P 35
When Codec >Select is set to MPEG HD422.
1920x1080 50i 50
1920x1080 25P 50
1280x720 50P 50
1280x720 25P 50

» “---"is grayed out when Codec >Select is set to RAW.

* The fixed values are grayed out when Codec >Select is set to
RAW & XAVC-I, RAW & XAVC-L, or RAW & MPEG HD

422.
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Item Sub-item setting Description
RAW Output Format Sets the recording format for an external RAW recorder.
* For NTSC systems:
When Codec >Select is set to an
item that includes RAW.
4096x2160 59.94P
4096x2160 29.97P
4096x2160 23.98P
2160x1080 59.94P
2160x1080 29.97P
2160x1080 23.98P
» For PAL systems:
When Codec >Select is set to an
item that includes RAW.
4096x2160 50P
4096x2160 25P
2160x1080 50P
2160x1080 25P
Genlock Reference Displays the genlock state. It displays the signal type if
Genlock settings  Internal / External(HD) / genlock is applied.
External(SD) Internal: External genlock not applied.
External(HD): Genlock to HD signal.
External(SD): Genlock to SD signal.
Assignable <1> to <6> Assigns functions to assignable buttons.
Button Off / Marker / Zebra / Peaking / Marker:
Assignable button Video Signal Monitor / Focus Turns the marker function on/off.
settings Magnifier x4/x8 / Focus Magnifier Zebra:
x4 / Focus Magnifier x8 / VF Turns the Zebra function on/off.
Mode / IRIS / Push Auto Iris / Peaking:

AGC / Push AGC/ SHUTTER /
Auto Exposure Level / Spotlight /
Backlight / ATW / ATW Hold /
Push AF/Focus Hold / SteadyShot
/ Color Bars / User Menu / Rec
Lamp / S&Q Motion / Picture
Cache Rec / Rec Review /
Thumbnail / Shot Mark1 / Shot
Mark?2 / Clip Flag OK / Clip Flag
NG / Clip Flag Keep /
DURATION/TC/U-BIT / High/
Low Key

Turns the peaking function on/off.
Video Signal Monitor:
Switches the video signal display (histogram, etc.).
Focus Magnifier x4/x8:
Focus Magnifier x4:
Focus Magnifier x8:
Turns the focus magnifier function on/off.
VF Mode:

Switches the viewfinder display between color and B&W.

IRIS:
Switches the iris function between Auto and Manual.
Push Auto Iris:

Enables the auto iris function while the button is pressed.

AGC:
Turns the AGC function on/off.
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Item

Sub-item setting

Description

Push AGC:

Enables the AGC function while the button is pressed.
SHUTTER:

Switches the shutter between Auto and Manual.
Auto Exposure Level:

Opens the Auto Exposure Level screen.
Spotlight:

Switches between Spotlight and Standard.
Backlight:

Switches between Backlight and Standard.
ATW:

Turns the ATW function on/off.
ATW Hold:

Pauses ATW function operation.
Push AF/Focus Hold:

Runs the push auto focus function or focus hold function.
SteadyShot:

Switches between Active SteadyShot, SteadyShot, and Off.
Color Bars:

Turns the color bars on/off.
User Menu:

Opens/closes the User menu.
Rec Lamp:

Turns the recording indicator on/off.
S&Q Motion:

Turns Slow & Quick Motion on/off.
Picture Cache Rec:

Turns picture cache recording mode on/off.
Rec Review:

Turns the Rec Review function on/off.
Thumbnail:

Opens/closes the thumbnail screen.
Shot Mark1:

Runs the Add Shot Mark1 function.
Shot Mark?2:

Runs the Add Shot Mark?2 function.
Clip Flag OK:

Runs the Add OK function.

Press twice to execute Delete Clip Flag.
Clip Flag NG:

Runs the Add NG function.

Press twice to execute Delete Clip Flag.
Clip Flag Keep:

Runs the Add Keep function.

Press twice to execute Delete Clip Flag.
DURATION/TC/U-BIT:

Switches between Time Code, Users Bit, and Duration.
High/Low Key:

Switches between High Key, Low Key, and Off.
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Item Sub-item setting Description
Assignable Assignable Dial Assigns functions to the assignable dial on the grip remote
Dial Off / ISO/Gain/EI / IRIS / control.
Assignable dial Focus / Audio Input Level ISO/Gain/EI: Adjusts the gain or EI.
settings IRIS: Adjusts the iris.
Focus: Adjusts the focus.
Audio Input Level: Adjusts the audio level.
IRIS Dial Assigns functions to the IRIS dial.
(Same settings as Assignable
Dial)
Assignable Dial Direction Sets the direction of rotation of the assignable dial on the grip
Normal / Opposite remote control.
Normal: Turn in forward direction.
Opposite: Turn in opposite direction.
IRIS Dial Direction Sets the direction of rotation of the IRIS dial.
Normal / Opposite Normal: Turn in forward direction.
Opposite: Turn in opposite direction.
Rec Lamp Rec Lamp Turns the recording indicator on/off.
Recording On/ Off
indicator settings
Fan Control Fan Control Mode Sets the control mode of the camcorder fan.
Fan control mode Auto / Minimum / Off in Rec

settings

Even when “Off in Rec” is selected, the fan will operate if the
internal temperature of the camcorder rises above a certain
value.

HOLD Switch  with Rec Button Sets whether or not to lock the recording button.
Setting On/ Off

Hold switch with Hand Grip Remote Sets whether to lock operation of the grip remote control.
settings On / Off

Lens Zoom Ring Direction Sets the direction of zoom ring operation.

Lens settings

Left(W)/Right(T) / Right(W)/
Left(T)

Enabled only when using an E-mount lens that supports zoom
ring direction switching.

Distortion Comp.
Auto / Off

Turns automatic distortion compensation on/off.

 Not available in picture cache recording mode or when
recording.

* Distortion compensation is not applied during QFHD
recording.

Language
Language settings

Select

Sets the display language.
SET: Set language.
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Item Sub-item setting Description
Clock Set Time Zone Sets the time difference from UTC in 30-minute units.
Internal clock UTC 12:00 Kwajalein to UTC
settings +14:00
Date Mode Selects the display format for dates.
YYMMDD / MMDDYY / YYMMDD: Year, month, day
DDMMYY MMDDY'Y: Month, day, year
DDMMYY: Day, month, year
12H/24H Selects the clock display format.
12H/ 24H 12H: 12-hour mode
24H: 24-hour mode
Date Sets the current date.
SET: Set the value.
Time Sets the current time.
SET: Set the value.
Country NTSC/PAL Area Sets the region of use.
Region settings NTSC Area/PAL Area

Hours Meter

Hours (System)

Displays the accumulated hours of use (cannot be reset).

Hours meter

Hours (Reset)

Displays the accumulated hours of use (can be reset).

tti
settngs Reset Resets the Hours (Reset) display to 0.
Execute / Cancel Execute: Reset
Basic User Name Sets a desired user name (1 to 16 alphanumeric characters).
Authentication (admin) SET: Set the value.
Basic network Password Sets a password (1 to 16 alphanumeric characters).
authentication (pxw-fs7) SET: Set the value.
settings
Wi-Fi Wi-Fi Selects whether to enable or disable Wi-Fi connection.
Wireless LAN Enable / Disable
con.nection SSID & Password Displays the SSID and password.
settings Wi-Fi Direct Connection Starts a “Wi-Fi Direct” network connection.
Execute / Cancel Execute: Connect
Client Displays information about the connected client device
(model name and MAC address).
IP Address Displays the IP address of the camcorder.
192.168.1.1 m
Not displayed when using the CBK-WA100.
Subnet Mask Displays the subnet mask.
255.255.0.0 m
Not displayed when using the CBK-WA100.
MAC Address Displays the MAC address of the Wi-Fi module attached to
the camcorder.
Regenerate Password Creates a new password.
Execute / Cancel Execute: Run
GPS GPS Turns the GPS function on/off.
GPS settings On/ Off

The GPS modaule is built into the handle.
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Item Sub-item setting Description

IR Remote Setting Enables/disables control from the supplied infrared remote
Remote control On/ Off control.

settings

Camera Low BATT Sets the remaining battery level to display a battery low-
Battery Alarm 5% /10% / 15% / -1 45% / voltage alarm (5% increments).

Battery low- 50%

voltage alarm BATT Empty Sets the remaining battery level to display a battery empty
settings 3% to 7% alarm.

Camera DC IN DC Low Voltagel Sets the voltage to display a DC IN low input voltage alarm.
Alarm 115V 170V

Input voltage DC Low Voltage2 Sets the voltage to display a DC IN insufficient input voltage
alarm settings 11.0Vto 140V alarm.

Ext. Unit Near End:Info Battery Sets the remaining battery level to display a Info-Lithium
Battery Alarm 5% to 100% battery low-voltage alarm (5% increments).

XDCA-FS7 End:Info Battery Sets the remaining battery level to display a Info-Lithium
battery settings 0% to 5% battery end alarm and to stop media access.

Near End:Sony Battery

11.5V to 17.0V

Sets the remaining battery level to display a battery low-
voltage alarm for a non Info-Lithium battery.

End:Sony Battery
11.0Vto 11.5V

Sets the remaining battery level to display a battery end alarm
for a non Info-Lithium battery and to stop media access.

Near End:Other Battery
11.5V to 17.0V (11.8V)

Sets the remaining battery level to display a battery low-
voltage alarm for an Anton/Bauer battery.

End:Other Battery
11.0V to 14.0V

Sets the remaining battery level to display a battery end alarm
for an Anton/Bauer battery and to stop media access.

Detected Battery

Displays the type of battery connected to the XDCA-FS7.
If a battery is connected to the XDCA-FS7, “Info Battery,”
“Sony Battery,” or “Other Battery” is displayed. If a DC
source is connected, “DC IN” is displayed.

If powered by a battery or DC source connected to the

Ext. Unit DC IN
Alarm
XDCA-FS7 input
voltage alarm

camcorder, *“ --- 7 is displayed.
DC Low Voltagel Sets the voltage to display a DC IN low input voltage alarm.
11.5V to 17.0V
DC Low Voltage2 Sets the voltage to display a DC IN insufficient input voltage

11.0V to 14.0V

alarm.

settings

All Reset Reset Resets all settings to their factory defaults.

Reset factory Execute / Cancel Execute: Reset

defaults

APR APR Runs APR (Automatic Pixel Restoration) for image sensor
Run APR Execute / Cancel auto adjustment.

Execute: Run

Always attach the lens cap before running APR.

Camera Config HD/2K Modulation

Down-converter
output settings

High / Low

Sets the down-converter output bandwidth for conversion to
HD and 2K
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Item Sub-item setting Description
Version Number Displays the software version of the camcorder.
Display version X.XX

Version Up Upgrades the camcorder.*

Execute / Cancel

Execute: Run
* Upgrading updates the camcorder software.

Ext. Unit Version Number
X.XX

Displays the software version of the XDCA-FS7.

Ext. Unit Version Up
Execute / Cancel

Upgrades the XDCA-FS7.*
Execute: Run
* Upgrading updates the XDCA-FS7 software.
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Connecting External Monitors and Recording Devices

To display recorded/playback pictures on an
external monitor, select the camcorder output
signal and use an appropriate cable for the
monitor to be connected.

You can also connect recording devices, such as a
VTR, and record the output signal from the
camcorder.

You can display the same information that is
visible in the viewfinder, such as status
information and menus, on an external monitor.
Set Output Display (page 71) in the Video menu
to “On” for the corresponding type of signal to
output to the monitor.

SDI OUT connector (BNC type)

Turn the output on/off and set the output format
using the Video menu (page 70).

Use a commercially available 75 Q coaxial cable
for connection.

Check that the connection between the camcorder and
the external device is grounded before turning the
devices on.

(It is recommended that the camcorder and external
device be turned on after connecting the 75 Q coaxial
cable.)

If the external device must be connected to the
camcorder while the camcorder is on, connect the 75 Q
coaxial cable to the external device first and then connect
it to the camcorder.

To start recording on the camcorder and external
device simultaneously

With SDI signal output enabled, set SDI/HDMI

Rec Control (page 77) >Setting in the Recording
menu to “On” to enable output of a REC trigger

signal to the external device connected to the SDI
OUT connector. This will synchronize recording
on the external device with the camcorder.

If a connected external device does not support a REC
trigger signal, the device cannot be operated.
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HDMI OUT connector (Type A connector)

Turn the output on/off and set the output format
using the Video menu (page 70).

Use a commercially available high-speed HDMI
cable for connection.

Select the type of the connected device using
HDMI Target Device (page 104) in the Video
menu.

RAW OUT connector (BNC type)

Attaching an XDCA-FS7 Extension Unit to the
camcorder provides support for an external RAW
recorder, such as the AXS-RS5, to be connected to
the RAW OUT connector of the XDCA-FS7

(page 31).



External Synchronization

When shooting using multiple camcorder units,
the camcorders can be synchronized to a specific
reference signal or timecodes synchronized via
the Genlock connector of the XDCA-FS7 units
(page 12) attached to the camcorders.

The camcorder battery pack cannot be used when an
XDCA-FS7 unit is attached to the camcorder. You must
attach a battery pack to the XDCA-FS7 or connect an
external power supply.

Synchronizing the phase of the video
signals (genlock)

Enable genlock by supplying a reference signal to
the Genlock connector (page 12) of the
XDCA-FS7 units connected to the camcorders.
The reference signals that can be used vary
depending on the frame rate of the selected
recording format.

For NTSC Area

Frame rate of
recording format

Valid reference signals

59.94P 1920 x 1080 59.94i
720 x 486 59.94i
1280 x 720 59.94P

29.97P 1920 x 1080 59.94i
720 x 486 59.94i

23.98P 1920 x 1080 47.95i
(23.98PsF)

59.94i 1920 x 1080 59.94i
720 x 486 59.94i

For PAL Area

Frame rate of
recording format

Valid reference signals

50P 1920 x 1080 501
720 x 576 50i

1280 x 720 50P

25P 1920 x 1080 50i

720 x 576 501

50i 1920 x 1080 50i

720 x 576 50i
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« If the selected recording format is 1280x720 60P, you
must supply both a video signal and a time signal.

« If the reference signal is unstable, genlock cannot be
achieved.

* The subcarrier is not synchronized.

Locking the timecode to other devices

Set the unit that supplies the timecode to a mode
in which the timecode output keeps running (such
as Free Run or Clock).

1 Set Timecode in the TC/UB menu as
follows.

Mode: Preset
Run: Free Run

2 Press the assignable button (page 42)
assigned with the DURATION/TC/
U-BIT function to display the timecode
on the screen.

3 Check that the TC IN/OUT switch
(page 12) on the XDCA-FS7 is set to the
IN position, and supply an HD or SD
reference video signal and a timecode
synchronized to the video signal to the
Genlock and TC IN/OUT connectors,
respectively.

The timecode generator of the camcorder
acquires lock with the reference timecode, and
“EXT-LK” appears on the screen.

Once about ten seconds have elapsed after the
timecode locks, the external lock state is
maintained even if the external reference
timecode source is disconnected.

Check that the supplied reference timecode and the
reference video signal are in a phase relationship that
complies with the SMPTE timecode standard.

When operating with external lock, the timecode
instantly acquires lock with the external timecode and
the external timecode value appears in the data display
area. However, do not start recording immediately.
Wait for a few seconds until the timecode generator
stabilizes before recording.

If the frequency of the reference video signal and the
frame frequency on the camcorder are not the same,
lock cannot be acquired and the camcorder will not
operate properly. If this occurs, the timecode will not
acquire successful lock with the external timecode.



¢ If the external timecode source is disconnected, the
timecode may shift by one frame per hour with respect
to the reference timecode.

To release external lock

Change the Timecode setting in the TC/UB menu,

or turn the camcorder off.

External lock is also released if you start

recording in Slow & Quick Motion mode.

Synchronizing the timecode of another
device with the timecode of the
camcorder

Set the unit that supplies the timecode to a mode
in which the timecode output keeps running (such
as Free Run or Clock).

1 Set the timecode of the camcorder using
the Timecode (page 76) in the TC/UB
menu.

2 Check that the TC IN/OUT switch
(page 12) is set to the OUT position, and
connect the TC IN/OUT connector and
Genlock connector (page 12) to the
timecode input and reference signal
input, respectively, of the device you
want to synchronize.
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Managing/Editing Clips
using a Computer

Connecting using a USB Cable

Using an XQD card reader (option)

Connect an MRW-E80 XQD Card Reader
(option) using a USB cable, and insert a memory
card in the slot. The memory card is recognized as
a computer extension drive.

Using mass storage mode

Connect the camcorder using a USB cable, and
insert a memory card in the slot. The memory
card is recognized as a computer extension drive.

1 Turn the camcorder POWER switch to
the ON position.

A message appears on the screen or
viewfinder asking whether to enable USB
connection.

The USB connection confirmation message is not
displayed while another confirmation message or
progress message is displayed, for example, when
formatting or restoring an XQD memory card.
The confirmation message is displayed when the
formatting or restoring execution ends. The USB
confirmation message is also not displayed when
the clip properties screen is displayed. The message
is displayed when processing ends or when you
return to the thumbnail screen.

2 Turn the SEL/SET dial and select
Execute.



3 on Windows, check that the card is
added as a removable disk in the “My
Computer” window.

On Macintosh, check that a folder
called “NO NAME” or “Untitled”
(editable) is created on the Desktop.

* Do not perform the following operations if the access
lamp is lit red.
- Turning the power off
- Disconnecting the power cord
- Removing the XQD memory card
- Disconnecting the USB cable

* Operation is not guaranteed to work on all computers.

Using nonlinear editing systems

In a nonlinear editing system, editing software
(option) that supports the formats recorded by the
camcorder is required.

Use dedicated application software to save the
clips you want to edit on the HDD of the
computer beforehand.
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Appendix

Usage Precautions

The fan is a consumable part that will need
periodic replacement.

When operating at room temperature, a normal
replacement cycle will be about 5 years.
However, this replacement cycle represents only
a general guideline and does not imply that the
life expectancy of this part is guaranteed. For
details on parts replacement, contact your dealer.

If the unit is suddenly taken from a cold to a warm
location, or if ambient temperature suddenly
rises, moisture may form on the outer surface of
the unit and/or inside of the unit. This is known as
condensation. If condensation occurs, turn off the
unit and wait until the condensation clears before
operating the unit. Operating the unit while
condensation is present may damage the unit.

The LCD panel fitted to this unit is manufactured
with high precision technology, giving a
functioning pixel ratio of at least 99.99%. Thus a
very small proportion of pixels may be “stuck”,
either always off (black), always on (red, green,
or blue), or flashing. In addition, over a long
period of use, because of the physical
characteristics of the liquid crystal display, such
“stuck” pixels may appear spontaneously. These
problems are not a malfunction. Note that any
such problems have no effect on recorded data.

The battery terminal of this unit (the connector for
battery packs and AC adaptors) is a consumable
part.

Power may not be supplied to the unit properly if
the pins of the battery terminal are bent or
deformed by shock or vibrations, or if they
become corroded due to prolonged outdoor use.
Periodic inspections are recommended to keep
the unit working properly and to prolong its
usable lifetime.

Contact a Sony service or sales representative for
more information about inspections.
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About the built-in rechargeable battery

The camcorder has a built-in rechargeable battery
for storing the date, time, and other settings even
when the camcorder is turned off. The
rechargeable battery will be fully discharged in
about 3 months if the AC adaptor is not
connected or the camcorder is used without the
battery pack attached. Use your camcorder after
charging the battery.

However, even if the built-in rechargeable battery
is not charged, the camcorder operation will not
be affected as long as you are not recording the
time and date.



Output Formats and Limitations

Video Formats and Output Signals

Factory default settings are shown in bold (for example, 2048x1080P (Level A)).

SDI OUT connector output formats

When Country >NTSC/PAL Area in the System menu is set to NTSC Area

Recording format settings SDI/HDMI output settings SDI output signal
(Rec Format >RAW Output Format |(Output Format >SDI and
and Video Format in the System HDMI in the Video menu)
menu) SDI HDMI
RAW Output Format 2048x1080P - 2048x1080 59.94P Level-A
4096x2160 59.94P (Level A)
Video Format (fixed value) 2048x1080P - 2048x1080 59.94P Level-B
19201080 59.94P (Level B)
1920x1080P 1920x1080P 1920x1080 59.94P Level-A
(Level A)
1920x1080P - 1920%x1080 59.94P Level-B
(Level B)
1920x1080i 1920x1080i 1920%x1080 59.94i
RAW Output Format 2048x1080P - 2048%1080 59.94P Level-A
4096x2160 59.94P (Level A)
Video Format (fixed value) 2048x1080P Z 2048x1080 59.94P Level-B
1280%x720 59.94P (Level B)
1920x1080P 1920x1080P 1920%x1080 59.94P Level-A
(Level A)
1920x1080P - 1920%x1080 59.94P Level-B
(Level B)
1280x720P 1280x720P 1280x720 59.94P
RAW Output Format - 4096x2160P No output
- - 3840x2160P No output
Video Format 1920x1080P | 1920<1080P | 1920x1080 59.94P Level-A
3840%x2160 59.94P (Level A)
1920x1080P - 1920%x1080 59.94P Level-B
(Level B)
1920x1080i 1920x1080i 1920x1080 59.94i
RAW Output Format 2048x1080P |- 2048x1080 59.94P Level-A
2048%1080 59.94P (Level A)
Video Format (fixed value) 2048x1080P - 2048x1080 59.94P Level-B
1920x1080 59.94P (Level B)
1920x1080P 1920x1080P 1920%x1080 59.94P Level-A
(Level A)
1920x1080P - 1920x1080 59.94P Level-B
(Level B)
1920x1080i 1920x1080i 1920%x1080 59.94i
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Recording format settings SDI/HDMI output settings SDI output signal
(Rec Format >RAW Output Format |(Output Format >SDI and
and Video Format in the System HDMI in the Video menu)
menu) SDI HDMI
RAW Output Format 2048x1080P |- 2048x1080 59.94P Level-A
2048x1080 59.94P (Level A)
Video Format (fixed value) 2048x1080P - 2048x1080 59.94P Level-B
1280x720 59.94P (Level B)
1920x1080P 1920x1080P 1920%x1080 59.94P Level-A
(Level A)
1920x1080P - 1920x1080 59.94P Level-B
(Level B)
1280x720P 1280x720P 1280x720 59.94P
RAW Output Format 2048x1080P - 2048x1080 59.94P Level-A
- (Level A)
Video Format 2048x1080P - 2048x1080 59.94P Level-B
1920x1080 59.94P (Level B)
1920x1080P | 1920x1080P 1920x1080 59.94P Level-A
(Level A)
1920x1080P - 1920x1080 59.94P Level-B
(Level B)
1920x1080i 1920x1080i 1920%x1080 59.94i
- 720x4801 No output
- 720%x480P No output
RAW Output Format 1920x1080i 1920x1080i 1920%x1080 59.94i
- - 720%x480i No output
Video Format - T20x430P No output
1920%x1080 59.94i
RAW Output Format 1280x720P 1280x720P 1280x720 59.94P
- - 720%x4801 No output
Video Format - 720%x480P No output
1280%x720 59.94P
RAW Output Format 2048x1080PsF |- 2048x1080 29.97PsF
4096x2160 29.97P 1920x1080PsF | 1920x1080i 1920x1080 29.97PsF
Video Format (fixed value)
1920%x1080 29.97P
RAW Output Format - 4096x2160P No output
- - 3840x2160P No output
Video Format 1920x1080PsE | 1920x10807 1920x1080 29.97PsF
3840%x2160 29.97P
RAW Output Format 2048x1080PsF |- 2048x1080 29.97PsF
2048x1080 29.97P 1920x1080PsF | 1920x1080i 1920%x1080 29.97PsF
Video Format (fixed value)
1920x1080 29.97P
RAW Output Format 2048x1080PsF |- 2048x1080 29.97PsF
- 1920x1080PsF | 1920x1080i 1920%x1080 29.97PsF
Video Format . T20x430i No output
1920%x1080 29.97P
RAW Output Format 1280x720P 1280x720P 1280720 59.94P (2-2RP)
- - 720%x480i No output
Video Format
1280x720 29.97P
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Recording format settings SDI/HDMI output settings SDI output signal
(Rec Format >RAW Output Format |(Output Format >SDI and
and Video Format in the System HDMI in the Video menu)
menu) SDI HDMI
RAW Output Format 2048x1080PsF |- 2048x1080 23.98PsF
4096x2160 23.98P 1920x1080PsF |- 1920x1080 23.98PsF
Video Format (fixed value) — 1920x1080P No output
1920x1080 23.98P
RAW Output Format - 4096x2160P No output
- - 3840x2160P No output
Video Format 1920<1080PSF | 1920x1080 23.98PsF
3840x2160 23.98P
- 1920x1080P No output
RAW Output Format 2048x1080PsF |- 2048%1080 23.98PsF
2048x1080 23.98P 1920x1080PsF |- 1920x1080 23.98PsF
Video Format (fixed value) — 1920x1080P No output
1920x1080 23.98P
RAW Output Format 2048x1080PsF |- 2048%1080 23.98PsF
- 1920x1080PsF |- 1920x1080 23.98PsF
Video Format - 1920x1080P | No output
1920x1080 23.98P - - -
1920x1080i (2- | 1920%x1080i (2- |1920x1080 59.94i (2-3PD)
3PD) 3PD)
- 720x480i (2- No output
3PD)
RAW Output Format 1280x720P (2- |1280x720P (2- |1280x720 59.94P (2-3PD)
- 3PD) 3PD)
Video Format - 720x480i (2- No output
1280x720 23.98P 3PD)
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When Country >NTSC/PAL Area in the System menu is set to PAL Area

Recording format settings SDI/HDMI output settings SDI output signal
(Rec Format >RAW Output Format |(Output Format >SDI and
and Video Format in the System HDMI in the Video menu)
menu) SDI HDMI
RAW Output Format 2048x1080P - 2048x1080 50P Level-A
4096x2160 50P (Level A)
Video Format (fixed value) 2048x1080P - 2048x1080 50P Level-B
1920%x1080 50P (Level B)
1920x1080P 1920x1080P 1920x1080 50P Level-A
(Level A)
1920x1080P - 1920%x1080 50P Level-B
(Level B)
1920x1080i 1920x1080i 1920%x1080 501
RAW Output Format 2048x1080P - 2048x1080 50P Level-A
4096x2160 50P (Level A)
Video Format (fixed value) 2048x1080P - 2048x1080 50P Level-B
1280x720 50P (Level B)
1920x1080P 1920x1080P 1920%x1080 50P Level-A
(Level A)
1920x1080P - 1920x1080 50P Level-B
(Level B)
1280x720P 1280x720P 1280x720 50P
RAW Output Format - 4096x2160P No output
- - 3840x2160P No output
Video Format 1920x1080P | 1920<1080P | 1920x1080 50P Level-A
3840%x2160 50P (Level A)
1920x1080P - 1920%x1080 50P Level-B
(Level B)
1920x1080i 1920x1080i 1920%x1080 501
RAW Output Format 2048x1080P |- 2048x1080 50P Level-A
2048x1080 50P (Level A)
Video Format (fixed value) 2048x1080P - 2048x1080 50P Level-B
19201080 50P (Level B)
1920x1080P 1920x1080P 1920x1080 50P Level-A
(Level A)
1920x1080P - 1920x1080 50P Level-B
(Level B)
1920x1080i 1920x1080i 1920%x1080 50i
RAW Output Format 2048x1080P |- 2048x1080 50P Level-A
2048%x1080 50P (Level A)
Video Format (fixed value) 2048x1080P - 2048x1080 50P Level-B
1280x720 50P (Level B)
1920x1080P 1920x1080P 1920x1080 50P Level-A
(Level A)
1920x1080P - 1920%x1080 50P Level-B
(Level B)
1280x720P 1280x720P 1280%x720 50P
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Recording format settings SDI/HDMI output settings SDI output signal
(Rec Format >RAW Output Format |(Output Format >SDI and
and Video Format in the System HDMI in the Video menu)
menu) SDI HDMI
RAW Output Format 2048x1080P - 2048x1080 50P Level-A
- (Level A)
Video Format 2048x1080P - 2048x1080 50P Level-B
1920%x1080 50P (Level B)
1920x1080P 1920x1080P 1920x1080 50P Level-A
(Level A)
1920x1080P - 1920%x1080 50P Level-B
(Level B)
1920x1080i 1920x1080i 1920x1080 50i
- 720x576i No output
- 720x576P No output
RAW Output Format 1920x1080i 1920x1080i 1920x1080 50i
- - 720%x576i No output
Video Format - 720x576P No output
1920%x1080 501
RAW Output Format 1280x720P 1280x720P 1280720 50P
- - 720x576i No output
Video Format - 720x576P No output
1280x720 50P
RAW Output Format 2048x1080PsF |- 2048x1080 25PsF
4096x2160 25P 1920x1080PsF | 1920x1080i 1920x1080 25PsF
Video Format (fixed value)
1920%x1080 25P
RAW Output Format - 4096x2160P No output
- - 3840x2160P No output
Video Format 1920x1080PsF | 192010801 1920x1080 25PsF
3840%x2160 25P
RAW Output Format 2048x1080PsF |- 2048x1080 25PsF
2048x1080 25P 1920x1080PsF | 1920x1080i 1920x1080 25PsF
Video Format (fixed value)
1920%x1080 25P
RAW Output Format 2048x1080PsF |- 2048%1080 25PsF
- 1920x1080PsF |1920x1080i 1920x1080 25PsF
Video Format - 7205761 No output
1920x1080 25P
RAW Output Format 1280x720P 1280x720P 1280x720 50P (2-2RP)
- - 7205761 No output
Video Format
1280%x720 25P
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HDMI OUT connector output formats

When Country >NTSC/PAL Area in the System menu is set to NTSC Area

Recording format settings SDI/HDMI output settings HDMI output signal
(Rec Format >RAW Output Format |(Output Format >SDI and
and Video Format in the System HDMI in the Video menu)
menu) SDI HDMI
RAW Output Format 2048x1080P |- No output
4096x2160 59.94P (Level A)
Video Format (fixed value) 2048x1080P _ No output
1920x1080 59.94P (Level B)
1920x1080P 1920x1080P 1920%x1080 59.94P
(Level A)
1920x1080P - No output
(Level B)
1920x1080i 1920x10801 1920x1080 59.94i
RAW Output Format 2048x1080P |- No output
4096x2160 59.94P (Level A)
Video Format (fixed value) 2048x1080P _ No output
1280x720 59.94P (Level B)
1920x1080P 1920x1080P 1920x1080 59.94P
(Level A)
1920x1080P - No output
(Level B)
1280x720P 1280x720P 1280x720 59.94P
RAW Output Format - 4096x2160P 4096x2160 59.94P
- - 3840x2160P 3840x2160 59.94P
Video Format 1920<1080P | 1920x1080P | 1920x1080 59.94P
3840x2160 59.94P (Level A)
1920x1080P - No output
(Level B)
1920x1080i 1920x10801 1920x1080 59.94i
RAW Output Format 2048x1080P |- No output
2048x%1080 59.94P (Level A)
Video Format (fixed value) 2048x1080P _ No output
1920x1080 59.94P (Level B)
1920x1080P 1920x1080P 1920x1080 59.94P
(Level A)
1920x1080P - No output
(Level B)
1920x10801 1920x10801 1920x1080 59.94i
RAW Output Format 2048x1080P |- No output
20481080 59.94P (Level A)
Video Format (fixed value) 2048x1080P _ No output
1280x720 59.94P (Level B)
1920x1080P 1920x1080P 1920x1080 59.94P
(Level A)
1920x1080P - No output
(Level B)
1280x720P 1280x720P 1280x720 59.94P
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Recording format settings SDI/HDMI output settings HDMI output signal
(Rec Format >RAW Output Format |(Output Format >SDI and
and Video Format in the System HDMI in the Video menu)
menu) SDI HDMI
RAW Output Format 2048x1080P - No output
- (Level A)
Video Format 2048x1080P - No output
1920x1080 59.94P (Level B)
1920x1080P | 1920x1080P | 19201080 59.94P
(Level A)
1920x1080P - No output
(Level B)
1920x1080i 1920x1080i 1920x1080 59.94i
- 720x480i 720%480 59.94i
- 720x480P 720x480 59.94P
RAW Output Format 1920x1080i 1920x1080i 1920x1080 59.94i
- - 720x480i 720%x480 59.94i
Video Format . 720x480P 720x480 59.94P
1920x1080 59.94i
RAW Output Format 1280x720P 1280x720P 1280x720 59.94P
- - 720x480i 720%x480 59.94i
Video Format - 720x430P 720x480 59.94P
1280x720 59.94P
RAW Output Format 2048x1080PsF |- No output
4096x2160 29.97P 1920x1080PsF | 1920x1080i 1920%x1080 29.97PsF
Video Format (fixed value)
1920x1080 29.97P
RAW Output Format - 4096x2160P 4096x2160 29.97P
- - 3840x2160P  |3840x2160 29.97P
Video Format 1920x1080PsF | 1920x1080i 1920x1080 29.97PsF
38402160 29.97P
RAW Output Format 2048x1080PsF |- No output
2048x1080 29.97P 1280x720P 1280%720P 1280%720 59.94P (2-2RP)
Video Format (fixed value)
1280%720 29.97P
RAW Output Format 2048x1080PsF |- No output
- 1920x1080PsF | 1920x1080i 1920x1080 29.97PsF
Video Format Z 720x480i 720x480 59.94i (PsF)
1920x1080 29.97P
RAW Output Format 1280x720P 1280x720P 1280720 59.94P (2-2RP)
- - 720x480i 720x480 59.94i (PsF)
Video Format
1280%720 29.97P
RAW Output Format 2048x1080PsF |- No output
4096x2160 23.98P 1920x1080PsF | — No output
Video Format (fixed value) - 1920x1080P 1920x1080 23.98P (Pure)
1920x1080 23.98P
RAW Output Format - 4096x2160P 4096x2160 23.98P
- - 3840x2160P  |3840x2160 23.98P
Video Format 1920<1080PSF |- No output
38402160 23.98P
- 1920x1080P 1920x1080 23.98P (Pure)
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Recording format settings SDI/HDMI output settings HDMI output signal
(Rec Format >RAW Output Format |(Output Format >SDI and
and Video Format in the System HDMI in the Video menu)
menu) SDI HDMI
RAW Output Format 2048x1080PsF |- No output
2048x1080 23.98P 1920x1080PsF | — No output
Video Format (fixed value) - 1920x1080P 1920x1080 23.98P (Pure)
1920x1080 23.98P
RAW Output Format 2048x1080PsF |- No output
- 1920x1080PsF |- No output
Video Format - 1920x1080P 1920x1080 23.98P (Pure)

1920x1080 23.98P

1920x1080i (2-
3PD)

1920x1080i (2-
3PD)

1920x1080 59.94i (2-3PD)

720x480i (2-

720x480 59.94i (2-3PD)

3PD)
RAW Output Format 1280x720P (2- | 1280x720P (2- | 1280x720 59.94P (2-3PD)
_ 3PD) 3PD)
Video Format - 720x480i (2- 720x480 59.94i
1280x720 23.98P 3PD)
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When Country >NTSC/PAL Area in the System menu is set to PAL Area

Recording format settings SDI/HDMI output settings HDMI output signal
(Rec Format >RAW Output Format |(Output Format >SDI and
and Video Format in the System HDMI in the Video menu)
menu) SDI HDMI
RAW Output Format 2048x1080P - No output
4096x2160 50P (Level A)
Video Format (fixed value) 2048x1080P _ No output
19201080 50P (Level B)
1920x1080P 1920x1080P 1920%x1080 50P
(Level A)
1920x1080P - No output
(Level B)
1920x10801 1920x1080i 1920x1080 50i
RAW Output Format 2048x1080P |- No output
4096x2160 50P (Level A)
Video Format (fixed value) 2048x1080P _ No output
1280x720 50P (Level B)
1920x1080P 1920x1080P 1920%x1080 50P
(Level A)
1920x1080P - No output
(Level B)
1280x720P 1280x720P 1280x720 50P
RAW Output Format - 4096x2160P 4096x2160 50P
- - 3840x2160P 3840%x2160 50P
Video Format 1920<1080P | 1920x1080P | 1920x1080 50P
3840%x2160 50P (Level A)
1920x1080P - No output
(Level B)
1920x1080i 1920x1080i 1920%x1080 50i
RAW Output Format 2048x1080P |- No output
2048x1080 50P (Level A)
Video Format (fixed value) 2048x1080P _ No output
1920x1080 50P (Level B)
1920x1080P 1920x1080P 1920%x1080 50P
(Level A)
1920x1080P - No output
(Level B)
1920x10801 1920x1080i 1920x1080 50i
RAW Output Format 2048x1080P - No output
2048%x1080 50P (Level A)
Video Format (fixed value) 2048x1080P _ No output
1280x720 50P (Level B)
1920x1080P 1920x1080P 1920%x1080 50P
(Level A)
1920x1080P - No output
(Level B)
1280x720P 1280x720P 1280%x720 50P
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Recording format settings SDI/HDMI output settings HDMI output signal
(Rec Format >RAW Output Format |(Output Format >SDI and
and Video Format in the System HDMI in the Video menu)
menu) SDI HDMI
RAW Output Format 2048x1080P - No output
_ (Level A)
Video Format 2048x1080P - No output
1920%x1080 50P (Level B)
1920x1080P  |1920x1080P | 1920x1080 50P
(Level A)
1920x1080P - No output
(Level B)
1920x1080i 1920x1080i 1920%x1080 501
- 720x576i 720x576 50i
- 720x576P 720576 50P
RAW Output Format 1920x1080i 1920x1080i 1920x1080 50i
- - 720x5761 720x576 50i
Video Format - 720x576P 720x576 50P
1920%x1080 501
RAW Output Format 1280x720P 1280x720P 1280x720 50P
- - 720x576i 720x576 50i
Video Format - 720x576P 720x576 50P
1280x720 50P
RAW Output Format 2048x1080PsF |- No output
4096x2160 25P 1920x1080PsF | 1920x1080i 1920x1080 25PsF
Video Format (fixed value)
1920%x1080 25P
RAW Output Format - 4096x2160P 4096x2160 25P
- - 3840x2160P  |3840x2160 25P
Video Format 1920x1080PsE | 1920x1080i 1920x1080 25PsF
3840x2160 25P
RAW Output Format 2048x1080PsF |- No output
2048x1080 25P 1920x1080PsF | 1920x1080i 1920x1080 25PsF
Video Format (fixed value)
1920%x1080 25P
RAW Output Format 2048x1080PsF |- No output
- 1920x1080PsF | 1920x1080i 1920x1080 50i (PsF)
Video Format - 720x576i 720x576 50i (PsF)
1920x1080 25P
RAW Output Format 1280x720P 1280x720P 1280x720 50P (2-2RP)
- - 720x5761 720x576 50i (PsF)
Video Format
1280%x720 25P

No playback picture is output if the video output resolution is higher than the resolution of the picture.
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HDMI output settings for HDMI devices

Output Setting >SHDMI Target |Output Display >SDI/HDMI in | HDMI output
Device in the Video menu the Video menu OSD On/Off |MLUT On/Off
Recorder (default) SDI=On, HDMI=On (default) - Follows SDI1
* Grayed out, cannot be selected.
SDI=On, HDMI=Off Off
SDI=0ff, HDMI=Off Off
Monitor SDI=0On, HDMI=On (default) On Follows SDI2
SDI=On, HDMI=Off -
* Grayed out, cannot be selected.
SDI=0Off, HDMI=Off Off

If the current Output Display setting becomes unavailable for selection after changing HDMI Target Device, the Output

Display setting changes as follows.

 Forcibly changes to the default value.

o If the default value is not available for selection, forcibly changes to “SDI=On, HDMI=On.”
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Operation Warnings

If a warning, caution, or operating condition that requires confirmation occurs on the camcorder, a
message is displayed in the viewfinder, the recording indicators start flashing, and a warning sound is
emitted.

The warning sound is emitted from the built-in speaker and headphones connected to the headphone
connector.

Error Messages

The camcorder will stop operation when the following kind of display occurs.

Viewfinder Warning Recording Cause and Solution

message sound indicator

E + error code Continuous High-speed Indicates an abnormality in the camcorder. Recording stops,
flashing even if @REC is displayed in the viewfinder.

Turn off the camcorder, and check for any problem with
connected devices, cables, or media. If the error persists when
the camcorder is turned on again, contact your Sony service
representative.

(If the camcorder does not turn off when the POWER switch
is set to OFF, remove the battery or disconnect the DC IN

supply.)

Warning Messages

Follow the instructions provided if the following display occurs.

Viewfinder Warning Recording Cause and Solution

message sound indicator

Media Near Full Intermittent  Flashing The remaining capacity on the XQD memory card is getting
low.

Replace at the earliest convenience.

Media Full Continuous High-speed Clips could not be recorded, copied, or split because there is
flashing no remaining capacity on the XQD memory card.
Replace immediately.
Battery Near End Intermittent Flashing The remaining capacity of the battery pack is getting low.
Recharge at the earliest convenience.
Battery End Continuous High-speed The battery pack is empty. Recording is disabled.
flashing Stop operation and replace the battery pack.
Temperature High Intermittent Flashing The internal temperature is high.

Turn off the camcorder and allow it to cool down before
operating it again.

Voltage Low Intermittent Flashing The DC IN voltage is low (level 1). Check the power source.
Insufficient Voltage Continuous High-speed The DC IN voltage is too low (level 2). Recording is disabled.
flashing Connect a different power source.
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Caution and Operation Messages

The following caution and operation messages may appear in the center of the screen. Follow the
instructions provided to resolve the issue.

Viewfinder message

Cause and Solution

Battery Error

An error was detected in the battery pack.

Please Change Battery Replace with a normal battery pack.
Backup Battery End The remaining capacity of the backup battery is insufficient.
Please Change Charge the backup battery.
Unknown Media(A)D A memory card that has been partitioned or a memory card containing
Please Change more clips that can be handled by the camcorder was inserted.
The card cannot be used in the camcorder, and must be replaced.
Cannot Use Media(A)D A card using a different file system or an unformatted card was inserted.
Unsupported File System The card cannot be used in the camcorder, and must be replaced or
formatted using the camcorder.
Media Error An error occurred on the memory card, and the card must be restored.

Media(A)!D) Needs to be Restored

Restore the memory card.

Media Error
Cannot Record to Media(A)!

The memory card may be damaged, and can no longer be used for
recording.

Playback is possible, so making a copy and replacing the memory card is
recommended.

Media Error The memory card may be damaged, and can no longer be used for
Cannot Use Media(A)) recording or playback.

The card cannot be used in the camcorder, and must be replaced.
Media(A)D Error Recording and playback was stopped because an error occurred while
Recording Halted using the memory card.
Playback Halted If the problem persists, replace the memory card.
Media Reached Rewriting Limit The memory card has reached the end of its life.
Change Media ( A)D Make a backup, and replace the card immediately If you continue using

the card, the card may not be able to record or play.

For details, refer to the operating instructions for the memory card.

Fan Stopped

The built-in fan stopped.
Avoid use at high temperatures, disconnect the power, and contact your
Sony service representative.

Invalid setting value was reset:

Media/Clip Naming/Camera Position

Please save All File again

The Clip Naming format setting was reset because an invalid ALL file
was loaded.
Configure the desired format settings, and try to save the ALL file again.

1) “Media(B)” is displayed for the card in slot B.
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Licenses

MPEG-4 Visual Patent Portfolio
License

THIS PRODUCT IS LICENSED UNDER THE
MPEG-4 VISUAL PATENT PORTFOLIO
LICENSE FOR THE PERSONAL AND NON-
COMMERCIAL USE OF A CONSUMER FOR

(i) ENCODING VIDEO IN COMPLIANCE
WITH THE MPEG-4 VISUAL STANDARD
(“MPEG-4 VIDEO”)

AND/OR

(ii) DECODING MPEG-4 VIDEO THAT WAS
ENCODED BY A CONSUMER ENGAGED IN
A PERSONAL AND NON-COMMERCIAL
ACTIVITY AND/OR WAS OBTAINED FROM
A VIDEO PROVIDER LICENSED BY MPEG
LA TO PROVIDE MPEG-4 VIDEO.

NO LICENSE IS GRANTED OR SHALL BE
IMPLIED FOR ANY OTHER USE.
ADDITIONAL INFORMATION INCLUDING
THAT RELATING TO PROMOTIONAL,
INTERNAL AND COMMERCIAL USES AND
LICENSING MAY BE OBTAINED FROM
MPEG LA, LLC. SEE HTTP://

WWW MPEGLA.COM

MPEG LA is offering licenses for (i)
manufacturing/sales of any storage media storing
MPEG-4 Visual video information (ii)
distribution/broadcasting of MPEG-4 Visual
video information in any manner (such as online
video distribution service, internet broadcasting,
TV broadcasting). Other usage of this product
may be required to obtain license from MPEGLA.
Please contact MPEG LA for any further
information. MPEG LA, L.L.C., 250 STEELE
STREET, SUITE 300, DENVER, COLORADO
80206, http://www.mpegla.com
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MPEG-2 Video Patent Portfolio
License

ANY USE OF THIS PRODUCT OTHER THAN
CONSUMER PERSONAL USE IN ANY
MANNER THAT COMPLIES WITH THE
MPEG-2 STANDARD FOR ENCODING
VIDEO INFORMATION FOR PACKAGED
MEDIA IS EXPRESSLY PROHIBITED
WITHOUT A LICENSE UNDER
APPLICABLE PATENTS IN THE MPEG-2
PATENT PORTFOLIO, WHICH LICENSE IS
AVAILABLE FROM MPEG LA, L.L.C., 250
STEELE STREET, SUITE 300, DENVER,
COLORADO 80206.

“PACKAGED MEDIA” means any storage
media storing MPEG-2 video information such as
DVD movie which are sold/distributed to general
consumers. Disc replicators or sellers of the
PACKAGED MEDIA need to obtain licenses for
their own business from MPEG LA. Please
contact MPEG LA for any further information.
MPEG LA. L.L.C., 250 STEELE STREET,
SUITE 300, DENVER, COLORADO 80206
http://www.mpegla.com



Obtaining Software Under the
GPL/LGPL License

This product uses software to which the GPL/
LGPL applies. This informs you that you have a
right to have access to, modity, and redistribute
source code for these software programs under
the conditions of the GPL/LGPL.

The source code is provided on the internet. Use
the following URL and follow the download
instructions.
http://www.sony.net/Products/Linux/common/
search.html

We would prefer that you do not contact us about
the contents of the source code.

For the content of these licenses, see
“Licensel.pdf” in the “License” folder of the
supplied CD-ROM.

Adobe Reader must be installed on your
computer to view PDF files.

If Adobe Reader is not installed on your
computer, you can download it by accessing the
following URL.

http://get.adobe.com/reader/
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END USER LICENSE AGREEMENT

IMPORTANT:

BEFORE USING THE SOFTWARE
CONTAINED IN THE SOLID STATE
MEMORY CAMCORDER, PLEASE READ
THIS END USER LICENSE AGREEMENT
(“EULA”) CAREFULLY. BY USING THE
SOFTWARE YOU ARE ACCEPTING THE
TERMS OF THIS EULA. IF YOU DO NOT
ACCEPT THE TERMS OF THIS EULA, YOU
MAY NOT USE THE SOFTWARE.

This EULA is a legal agreement between you and
Sony Corporation (“SONY”). This EULA
governs your rights and obligations regarding the
software of SONY and/or its third party licensors
(including SONY s affiliates) and their respective
affiliates (collectively, the “THIRD-PARTY
SUPPLIERS”) contained in the wireless adapter,
together with any updates/ upgrades provided by
SONY, any printed, on-line or other

electronic documentation for such software, and
any data files created by operation of such
software (collectively, the “SOFTWARE”).

Notwithstanding the foregoing, any software in
the SOFTWARE having a separate end user
license agreement (including, but not limited to,
GNU General Public license and Lesser/Library
General Public License) shall be covered by such
applicable separate end user license agreement in
lieu of the terms of this EULA to the extent
required by such separate end user license
agreement (“EXCLUDED SOFTWARE”).

SOFTWARE LICENSE

The SOFTWARE is licensed, not sold. The
SOFTWARE is protected by copyright and other
intellectual property laws and international
treaties.

COPYRIGHT

All right and title in and to the SOFTWARE
(including, but not limited to, any images,
photographs, animation, video, audio, music, text
and “applets” incorporated into the SOFTWARE)
is owned by SONY or one or more of the THIRD-
PARTY SUPPLIERS.

GRANT OF LICENSE
SONY grants you a limited license to use the
SOFTWARE solely in connection with the



wireless adapter and only for your individual use.
SONY and the THIRD-PARTY SUPPLIERS
expressly reserve all rights, title and interest
(including, but not limited to, all intellectual
property rights) in and to the SOFTWARE that
this EULA does not specifically grant to you.

REQUIREMENTS AND LIMITATIONS
You may not copy, publish, adapt, redistribute,
attempt to derive source code, modify, reverse
engineer, decompile, or disassemble any of the
SOFTWARE, whether in whole or in part, or
create any derivative works from or of the
SOFTWARE unless such derivative works are
intentionally facilitated by the SOFTWARE. You
may not modify or tamper with any digital rights
management functionality of the SOFTWARE.
You may not bypass, modify, defeat or
circumvent any of the functions or protections of
the SOFTWARE or any mechanisms operatively
linked to the SOFTWARE. You may not separate
any individual component of the SOFTWARE
for use on more than one wireless adapter unless
expressly authorized to do so by SONY. You may
not remove, alter, cover or deface any trademarks
or notices on the SOFTWARE. You may not
share, distribute, rent, lease, sublicense, assign,
transfer or sell the SOFTWARE. The software,
network services or other products other than
SOFTWARE upon which the SOFTWARE’S
performance depends might be interrupted or
discontinued at the discretion of the suppliers
(software suppliers, service suppliers, or SONY).
SONY and such suppliers do not warrant that the
SOFTWARE, network services, contents or other
products will continue to be available, or will
operate without interruption or modification.

EXCLUDED SOFTWARE AND OPEN
SOURCE COMPONENTS

Notwithstanding the foregoing limited license
grant, you acknowledge that the SOFTWARE
may include EXCLUDED SOFTWARE. Certain
EXCLUDED SOFTWARE may be covered by
open source software licenses (“Open Source
Components”), which means any software
licenses approved as open source licenses by the
Open Source Initiative or any substantially
similar licenses, including but not limited to any
license that, as a condition of distribution of the
software licensed under such license, requires
that the distributor make the software available in
source code format. If and to the extent disclosure
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is required, please visit www.sony.com/linux or
other SONY-designated web site for a list of
applicable OPEN SOURCE COMPONENTS
included in the SOFTWARE from time to time,
and the applicable terms and conditions
governing its use. Such terms and conditions may
be changed by the applicable third party at any
time without liability to you. To the extent
required by the licenses covering EXCLUDED
SOFTWARE, the terms of such licenses will
apply in lieu of the terms of this EULA. To the
extent the terms of the licenses applicable to
EXCLUDED SOFTWARE prohibit any of the
restrictions in this EULA with respect to such
EXCLUDED SOFTWARE, such restrictions will
not apply to such EXCLUDED SOFTWARE. To
the extent the terms of the licenses applicable to
Open Source Components require SONY to make
an offer to provide source code in connection with
the SOFTWARE, such offer is hereby made.

USE OF SOFTWARE WITH
COPYRIGHTED MATERIALS

The SOFTWARE may be capable of being used
by you to view, store, process and/or use content
created by you and/or third parties. Such content
may be protected by copyright, other intellectual
property laws, and/or agreements. You agree to
use the SOFTWARE only in compliance with all
such laws and agreements that apply to such
content. You acknowledge and agree that SONY
may take appropriate measures to protect the
copyright of content stored, processed or used by
the SOFTWARE. Such measures include, but are
not limited to, counting the frequency of your
backup and restoration through certain
SOFTWARE features, refusal to accept your
request to enable restoration of data, and
termination of this EULA in the event of your
illegitimate use of the SOFTWARE.

CONTENT SERVICE

PLEASE ALSO NOTE THAT THE
SOFTWARE MAY BE DESIGNED TO BE
USED WITH CONTENT AVAILABLE
THROUGH ONE OR MORE CONTENT
SERVICES (“CONTENT SERVICE”). USE OF
THE SERVICE AND THAT CONTENT IS
SUBJECT TO THE TERMS OF SERVICE OF
THAT CONTENT SERVICE. IF YOU
DECLINE TO ACCEPT THOSE TERMS,
YOUR USE OF THE SOFTWARE WILL BE
LIMITED. You acknowledge and agree that



certain content and services available through the
SOFTWARE may be provided by third parties
over which SONY has no control. USE OF THE
CONTENT SERVICE REQUIRES AN
INTERNET CONNECTION. THE CONTENT
SERVICEMAY BE DISCONTINUED AT ANY
TIME.

INTERNET CONNECTIVITY AND THIRD
PARTY SERVICES

You acknowledge and agree that access to certain
SOFTWARE features may require an Internet
connection for which you are solely responsible.
Further, you are solely responsible for payment of
any third party fees associated with your Internet
connection, including but not limited to Internet
service provider or airtime charges. Operation of
the SOFTWARE may be limited or restricted
depending on the capabilities, bandwidth or
technical limitations of your Internet connection
and service. The provision, quality and security of
such Internet connectivity are the sole
responsibility of the third party providing such
service.

EXPORT AND OTHER REGULATIONS
You agree to comply with all applicable export
and re-export restrictions and regulations of the
area or country in which you reside, and not to
transfer, or authorize the transfer, of the
SOFTWARE to a prohibited country or otherwise
in violation of any such restrictions or
regulations.

HIGH RISK ACTIVITIES

The SOFTWARE is not fault-tolerant and is not
designed, manufactured or intended for use or
resale as on-line control equipment in hazardous
environments requiring fail-safe performance,
such as in the operation of nuclear facilities,
aircraft navigation or communication systems, air
traffic control, direct life support machines, or
weapons systems, in which the failure of the
SOFTWARE could lead to death, personal injury,
or severe physical or environmental damage
(“HIGH RISK ACTIVITIES”). SONY, each of
the THIRD-PARTY SUPPLIERS, and each of
their respective affiliates specifically disclaim
any express or implied warranty, duty or
condition of fitness for HIGH RISK
ACTIVITIES.
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EXCLUSION OF WARRANTY ON
SOFTWARE

You acknowledge and agree that use of the
SOFTWARE is at your sole risk and that you are
responsible for use of the SOFTWARE. The
SOFTWARE is provided “AS IS,” without
warranty, duty or condition of any kind.

SONY AND EACH OF THE THIRD-PARTY
SUPPLIERS (for purposes of this Section, SONY
and each of the THIRD-PARTY SUPPLIERS
shall be collectively referred to as “SONY”)
EXPRESSLY DISCLAIM ALL
WARRANTIES, DUTIES OR CONDITIONS,
EXPRESS OR IMPLIED, INCLUDING, BUT
NOT LIMITED TO, THE IMPLIED
WARRANTIES OF MERCHANTABILITY,
NONINFRINGEMENT AND FITNESS FOR A
PARTICULAR PURPOSE. SONY DOES NOT
WARRANT OR MAKE ANY CONDITIONS
OR REPRESENTATIONS (A) THAT THE
FUNCTIONS CONTAINED IN ANY OF THE
SOFTWARE WILL MEET YOUR
REQUIREMENTS OR THAT THEY WILL BE
UPDATED, (B) THAT THE OPERATION OF
ANY OF THE SOFTWARE WILL BE
CORRECT OR ERROR-FREE OR THAT ANY
DEFECTS WILL BE CORRECTED, (C) THAT
THE SOFTWARE WILL NOT DAMAGE ANY
OTHER SOFTWARE, HARDWARE OR
DATA, (D) THAT ANY SOFTWARE,
NETWORK SERVICES (INCLUDING THE
INTERNET) OR PRODUCTS (OTHER THAN
THE SOFTWARE) UPON WHICH THE
SOFTWARE’S PERFORMANCE DEPENDS
WILL CONTINUE TO BE AVAILABLE,
UNINTERRUPTED OR UNMODIFIED, AND
(E) REGARDING THE USE OR THE
RESULTS OF THE USE OF THE SOFTWARE
IN TERMS OF ITS CORRECTNESS,
ACCURACY, RELIABILITY, OR
OTHERWISE.

NO ORAL OR WRITTEN INFORMATION OR
ADVICE GIVEN BY SONY OR AN
AUTHORIZED REPRESENTATIVE OF SONY
SHALL CREATE A WARRANTY, DUTY OR
CONDITION OR IN ANY WAY INCREASE
THE SCOPE OF THIS WARRANTY. SHOULD
THE SOFTWARE PROVE DEFECTIVE YOU
ASSUME THE ENTIRE COST OF ALL
NECESSARY SERVICING, REPAIR OR



CORRECTION. SOME JURISDICTIONS DO
NOT ALLOW THE EXCLUSION OF IMPLIED
WARRANTIES, SO THESE EXCLUSIONS
MAY NOT APPLY TO YOU.

LIMITATION OF LIABILITY

SONY AND EACH OF THE THIRD-PARTY
SUPPLIERS (for purposes of this Section, SONY
and each of the THIRD-PARTY SUPPLIERS
shall be collectively referred to as “SONY”")
SHALL NOT BE LIABLE FOR ANY
INCIDENTAL OR CONSEQUENTIAL
DAMAGES FOR BREACH OF ANY
EXPRESS OR IMPLIED WARRANTY,
BREACH OF CONTRACT, NEGLIGENCE,
STRICT LIABILITY OR UNDER ANY OTHER
LEGAL THEORY RELATED TO THE
SOFTWARE, INCLUDING, BUT NOT
LIMITED TO, ANY DAMAGES ARISING
OUT OF LOSS OF PROFITS, LOSS OF
REVENUE, LOSS OF DATA, LOSS OF USE
OF THE SOFTWARE OR ANY ASSOCIATED
HARDWARE, DOWN TIME AND USER’ S
TIME, EVEN IF ANY OF THEM HAVE BEEN
ADVISED OF THE POSSIBILITY OF SUCH
DAMAGES. IN ANY CASE, EACH AND ALL
OF THEIR AGGREGATE LIABILITY UNDER
ANY PROVISION OF THIS EULA SHALL BE
LIMITED TO THE AMOUNT ACTUALLY
PAID FOR THE PRODUCT. SOME
JURISDICTIONS DO NOT ALLOW THE
EXCLUSION OR LIMITATION OF
INCIDENTAL OR CONSEQUENTIAL
DAMAGES, SO THE ABOVE EXCLUSION
OR LIMITATION MAY NOT APPLY TO
YOU.

CONSENT TO USE OF NON-PERSONAL
INFORMATION, LOCATION DATA,DATA
SECURITY

You acknowledge and agree that SONY and its
affiliates, partners and agents may read, collect,
transfer, process and store certain information
collected from the SOFTWARE, including but
not limited to information about (i) the
SOFTWARE and (ii) the software applications,
contents and peripheral devices that interact with
your wireless adapter and the SOFTWARE
(“Information”). Information includes, but is not
limited to: (1) unique identifiers relating to your
wireless adapter and its components; (2)
performance of the wireless adapter, the
SOFTWARE and their components; (3)
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configurations of your wireless adapter, the
SOFTWARE and the software applications,
contents and peripheral devices that interact with
the wireless adapter and the SOFTWARE; (4) use
and frequency of use of the functions of (x) the
SOFTWARE, and (y) the software applications,
contents and peripheral devices that interact with
the SOFTWARE; and (5) location data, as
indicated below. SONY and its affiliates, partners
and agents may use and disclose Information
subject to applicable laws in order to improve its
products and services or to provide products or
services to you. Such uses include, but are not
limited to: (a) administering the functionalities of
the SOFTWARE; (b) to improve, service, update
or upgrade the SOFTWARE; (c) improving,
developing and enhancing the current and future
products and services of SONY and other parties;
(d) to provide you with information about the
products and services offered by SONY and other
parties; (e) complying with applicable laws or
regulations; and (f) to the extent offered,
providing you with location-based services of
SONY and other parties, as indicated below. In
addition, SONY retains the right to use
Information to protect itself and third parties from
illegal, criminal or harmful conduct.

Certain services available through the
SOFTWARE may rely upon location
information, including, but not limited to, the
geographic location of the wireless adapter. You
acknowledge that for the purpose of providing
such services, SONY, the THIRDPARTY
SUPPLIERS or their partners may collect,
archive, process and use such location data, and
that such services are governed by the privacy
policies of SONY or such third party. By
reviewed the privacy policies applicable to such
services and consent to such activities.

SONY, its affiliates, partners and agents will not
intentionally use Information to personally
identify the owner or user of the SOFTWARE
without your knowledge or consent. Any use of
Information will be in accordance with the
privacy policies of SONY or such third party.

Please contact applicable contact address of each
area or country for SONY” s current privacy

policy. Please contact applicable third parties for
privacy policies relating to personally identifiable



and other information you provide when you use
or access third party software or services.

Information may be processed, stored or
transferred to SONY, its affiliates or agents which
are located in countries outside of your country of
residence. Data protection and information
privacy laws in certain countries may not offer the
same level of protection as your country of
residence and you may have fewer legal rights in
relation to Information processed and stored in, or
transferred to, such countries. SONY will use
reasonable efforts to take appropriate technical
and organizational steps to prevent unauthorized
access to or disclosure of Information, but does
not warrant it will eliminate all risk of misuse of
such Information.

AUTOMATIC UPDATE FEATURE

From time to time, SONY or the THIRD-PARTY
SUPPLIERS may automatically update or
otherwise modify the SOFTWARE, including,
but not limited to, for purposes of enhancement of
security functions, error correction and
improvement of functions, at such time as you
interact with SONY’ s or third parties' servers, or
otherwise. Such updates or modifications may
delete or change the nature of features or other
aspects of the SOFTWARE, including, but not
limited to, functions you may rely upon. You
acknowledge and agree that such activities may
occur at SONY’ s sole discretion and that SONY
may condition continued use of the SOFTWARE
upon your complete installation or acceptance of
such update or modifications. Any updates/
modifications shall be deemed to be, and shall
constitute part of, the SOFTWARE for purposes
of this EULA. By acceptance of this EULA, you
consent to such update/modification.

ENTIRE AGREEMENT, WAIVER,
SEVERABILITY

This EULA and SONY’ s privacy policy, each as
amended and modified from time to time,
together constitute the entire agreement between
you and SONY with respect to the SOFTWARE.
The failure of SONY to exercise or enforce any
right or provision of this EULA shall not
constitute a waiver of such right or provision. If
any part of this EULA is held invalid, illegal, or
unenforceable, that provision shall be enforced to
the maximum extent permissible so as to maintain
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the intent of this EULA, and the other parts will
remain in full force and effect.

GOVERNING LAW AND JURISDICTION
The United Nations Convention on Contracts for
the International Sale of Goods shall not apply to
this EULA. This EULA shall be governed by the
laws of Japan, without regards to conflict of laws
provisions. Any dispute arising out of this EULA
shall be subject to the exclusive venue of the
Tokyo District Court in Japan, and the parties
hereby consent to the venue and jurisdiction of
such courts.

EQUITABLE REMEDIES

Notwithstanding anything contained in this
EULA to the contrary, you acknowledge and
agree that any violation of or noncompliance with
this EULA by you will cause irreparable harm to
SONY, for which monetary damages would be
inadequate, and you consent to SONY obtaining
any injunctive or equitable relief that SONY
deems necessary or appropriate in such
circumstances. SONY may also take any legal
and technical remedies to prevent violation of
and/or to enforce this EULA, including, but not
limited to, immediate termination of your use of
the SOFTWARE, if SONY believes in its sole
discretion that you are violating or intend to
violate this EULA. These remedies are in addition
to any other remedies SONY may have at law, in
equity or under contract.

TERMINATION

Without prejudice to any of its other rights,
SONY may terminate this EULA if you fail to
comply with any of its terms. In case of such
termination, you must: (i) cease all use, and
destroy any copies, of the SOFTWARE; (ii)
comply with the requirements in the section
below entitled “Your Account Responsibilities”.

AMENDMENT

SONY RESERVES THE RIGHT TO AMEND
ANY OF THE TERMS OF THIS EULA ATITS
SOLE DISCRETION BY POSTING NOTICE
ON A SONY DESIGNATED WEB SITE, BY
EMAIL NOTIFICATION TO AN EMAIL
ADDRESS PROVIDED BY YOU, BY
PROVIDING NOTICE AS PART OF THE
PROCESS IN WHICH YOU OBTAIN
UPGRADES/ UPDATES OR BY ANY OTHER
LEGALLY RECOGNIZABLE FORM OF
NOTICE. If you do not agree to the amendment,



you should promptly contact SONY for
instructions. Your continued use of the
SOFTWARE after the effective date of any such
notice shall be deemed your agreement to be
bound by such amendment.

THIRD-PARTY BENEFICIARIES

Each THIRD-PARTY SUPPLIER is an express
intended thirdparty beneficiary of, and shall have
the right to enforce, each provision of this EULA
with respect to the SOFTWARE of such party.

Should you have any questions concerning this
EULA, you may contact SONY by writing to
SONY at applicable contact address of each area
or country.

Copyright ¢ 2012 Sony Corporation.

Open Software Licenses

On the basis of license contracts between Sony
and the software copyright holders, this product
uses open software.

To meet the requirements of the software
copyright holders, Sony is obligated to inform
you of the content of these licenses.

For the content of these licenses, see
“Licensel.pdf” in the “License” folder of the
supplied CD-ROM.
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|
Specifications

General

Mass  Approx. 2.0 kg (4 1b 6.5 0z) (body only)
Dimensions
(Unit: mm (inch), body only)!

156 (6 1/,)

O

= =\
=)
=

239 (9 1/,)

1) The values for dimensions are approximate.

Power requirement
12VDC (11 Vto 17.0 V)
Power consumption
Approx. 19 W (body, SELP28135G
lens, XAVC-I QFHD 59.94P recording,
viewfinder on)
Operating temperature
0°Cto40°C (32 °F to 104 °F)
Storage temperature
—20 °C to +60 °C (-4 °F to +140 °C)
Continuous operating time
Approx. 60 minutes (using BP-U30)

Recording format (video)
XAVC Intra
AVC/H.264 High 4:2:2 Intra Profile
QFHD: CBG, 600 Mbps
HD: CBG, 222 Mbps
XAVC Long
AVC/H.264 High Profile
QFHD: VBR, 150 Mbps max., 4:2:0
Long



HD: VBR, 50 Mbps max., 4:2:2 Long
MPEG HD422

MPEG-2 Long GOP

HD422 mode: CBR, 50 Mbps, MPEG-2
422P@HL

Recording format (audio)

LPCM 24-bit, 48 kHz, 4-channel
(2-channel recording on camcorder)

Recording frame rate

XAVC Intra

3840 x 2160/59.94P, 50P, 29.97P,
23.98P, 25P

1920 x 1080/59.94P, 50P, 59.944i, 501,
29.97P, 23.98P, 25P

XAVC Long

3840 x 2160/59.94P, 50P, 29.97P,
23.98P, 25P

1920 x 1080/59.94P, 50P, 59.944i, 501,
29.97P, 23.98P, 25P

MPEG HD 422

1920 x 1080/59.941, 50i, 29.97P,
23.98P, 25P

1280 x 720/59.94P, 50P, 29.97P,
23.98P, 25P

Recording/playback time

XAVC Intra 3840 x 2160

59.94p
Approx. 22 minutes: Using
QD-G128A
Approx. 11 minutes: Using
QD-G64A

50p
Approx. 26 minutes: Using
QD-G128A
Approx. 13 minutes: Using
QD-G64A

29.97P
Approx. 44 minutes: Using
QD-G128A
Approx. 22 minutes: Using
QD-G64A

23.98P
Approx. 55 minutes: Using
QD-G128A
Approx. 27 minutes: Using
QD-G64A

25P
Approx. 52 minutes: Using
QD-G128A
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Approx. 26 minutes: Using
QD-G64A

XAVC Intra 1920 x 1080

59.94pP
Approx. 59 minutes: Using
QD-G128A
Approx. 30 minutes: Using
QD-G64A

50P
Approx. 71 minutes: Using
QD-G128A
Approx. 35 minutes: Using
QD-G64A

59.94i
Approx. 118 minutes: Using
QD-G128A
Approx. 59 minutes: Using
QD-G64A

50i
Approx. 141 minutes: Using
QD-G128A
Approx. 70 minutes: Using
QD-G64A

29.97P
Approx. 118 minutes: Using
QD-G128A
Approx. 59 minutes: Using
QD-G64A

23.98P
Approx. 147 minutes: Using
QD-G128A
Approx. 74 minutes: Using
QD-G64A

25P
Approx. 141 minutes: Using
QD-G128A
Approx. 70 minutes: Using
QD-G64A

XAVC Long 3840 x 2160
59.94P/50P
Approx. 87 minutes: Using
QD-G128A
Approx. 44 minutes: Using
QD-G64A
29.97P/23.98P/25P
Approx. 131 minutes: Using
QD-G128A
Approx. 66 minutes: Using
QD-G64A



XAVC Long 1920 x 1080

50M mode
Approx. 262 minutes: Using
QD-G128A
Approx. 131 minutes: Using
QD-G64A

35M mode
Approx. 374 minutes: Using
QD-G128A
Approx. 187 minutes: Using
QD-G64A

25M mode
Approx. 524 minutes: Using
QD-G128A
Approx. 262 minutes: Using
QD-G64A

MPEG HD 422
Approx. 262 minutes: Using
QD-G128A
Approx. 131 minutes: Using
QD-G64A

The recording/playback time may vary due to usage
conditions and memory characteristics.

Camera Section

Imaging device (type)
Super 35 equivalent CMOS image
sensor
Number of pixels
11.6 Megapixels (total),
8.8 Megapixels@17:9/
8.3 Megapixels@16:9 (effective)
ND filters
1: Clear
2: 1/4ND
3: 1/16ND
4: 1/64ND
Sensitivity
Video Gamma: T14 @ 24p
(2000 Ix, 89.9% reflectance, 3200K)
ISO sensitivity
S-Log3 Gamma ISO2000 (D55 light
source)
Minimum illumination

0.7 1x (18 dB, 23.98P, Shutter: OFF, ND

Clear, F1.4)
Lens mount
E-mount

Latitude
14-stop
Video S/N
57 dB (Video Gamma/Noise
Suppression: off)
Shutter speed
1/3 to 1/9000 sec. (23.98P)
Shutter angle
4.2° to 359.7°
5.6° to 180° (23.98P)
5.6° to 216° (59.94P)
5.6° to 300° (50P)
Slow & Quick Motion
XAVC QFHD: 1 to 60P,
XAVC HD: 1 to 180P
White balance
Preset mode, Memory mode A, B
(1500K to 50000K)
Gain -3,0,3,6,9,12,18dB
Gamma curve
STDI, STD2, STD3, STD4, STDS,
STD6, HG1, HG2, HG3, HG7, HGS,
S-Log3, USER1, USER2, USER3,
USER4

Audio Section

Sampling frequency
48 kHz
Quantization
24-bit
Frequency response
50 Hz to 20 kHz (+3 dB or less)
Dynamic range
90 dB (typical)
Distortion
0.08% or lower (=40 dBu input level)
Built-in speaker
Monaural
Built-in microphone
Monaural

Input/Output Section

Inputs

INPUT 1/2:
XLR type, 3-pin, female
LINE / MIC / MIC+48V switchable
MIC: Reference —40, —50, —60 dBu

Outputs
SDI OUT 1/2:



BNC type, 0.8 Vp-p, unbalanced (3G
HD/1.5G HD output)
SMPTE ST424/425 Level-A/B, 292M
standard compliant
4-channel audio
EARPHONE (stereo mini jack):
—16 dBu (reference level output,
maximum monitor volume, 16 € load)
HDMI: Type A, 19-pin

Other
DC IN: EIAJ compliant, 11 Vto 17 V DC
Extension unit connector:

Dedicated (144-pin)
Multi-interface shoe:

Dedicated (21-pin)
REMOTE:

2.5 @ 3-pole sub-mini type

USB:  2.0standard compliant, type AB mini for
mass storage (1)
Type A for W-LAN connection (1)
VF: Dedicated (40-pin)
Display Section

LCD monitor
Screen size
8.8 cm (3.5 inch) diagonal
Aspect ratio
16:9
Number of pixels
960 (H) x 540 (V)

Media Slot Section

XQD card slots for video recording (2)
UTILITY SD card slot (1)

Supplied Accessories

Viewfinder (including eyepiece, eyecup, rod,
clamp)
Grip remote control
USB wireless LAN module (IFU-WLM3)
Infrared remote control (RMT-845)
AC Adaptor
MPA-AC1 (USA and Canada model
only)
Rated input: 100 V to 240 V AC,
50 Hz/60 Hz, 0.4 A t0 0.75 A
Rated output: 12 VDC, 3 A
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AC-NBI12A (except USA and Canada
model)
Rated input: 100 V to 240 V AC,
50 Hz/60 Hz, 0.35 A to 0.65 A
Rated output: 12 V DC, 2.5 A
Battery pack (BP-U30)
Maximum voltage: 16.4 V DC
Nominal voltage: 14.4 V DC
Capacity: 28 Wh
Battery charger (BC-U1)
Power requirements: 100 V to 240 V
AC, 50 Hz/60 Hz
Power consumption: 38 W
Rated output: Charging 16.4 V, 1.9 A/
1.5A
Power cords (2)
Mini USB cable (1)
Option mounting stay (1)
Lens mount cap (1)
Handle connector protective cap (including two
M2 screws) (1)
USB wireless LAN module cap (1)
W-LAN connector cover spare (1)
Extension unit connector cover spare (1)
Accessory shoe kit (accessory shoe (1), shoe plate
(1), screws (4))
Before Using this Unit (1)
Operating Instructions (CD-ROM) (1)

Design and specifications are subject to change
without notice.

SONY WILL NOT BE LIABLE FOR
DAMAGES OF ANY KIND RESULTING
FROM A FAILURE TO IMPLEMENT
PROPER SECURITY MEASURES ON
TRANSMISSION DEVICES,
UNAVOIDABLE DATA LEAKS
RESULTING FROM TRANSMISSION
SPECIFICATIONS, OR SECURITY
PROBLEMS OF ANY KIND.




Notes

* Always make a test recording, and verify that
it was recorded successfully.

SONY WILL NOT BE LIABLE FOR
DAMAGES OF ANY KIND INCLUDING,
BUT NOT LIMITED TO,
COMPENSATION OR REIMBURSEMENT
ON ACCOUNT OF FAILURE OF THIS
UNIT OR ITS RECORDING MEDIA,
EXTERNAL STORAGE SYSTEMS OR
ANY OTHER MEDIA OR STORAGE
SYSTEMS TO RECORD CONTENT OF
ANY TYPE.

Always verify that the unit is operating
properly before use.

SONY WILL NOT BE LIABLE FOR
DAMAGES OF ANY KIND INCLUDING,
BUT NOT LIMITED TO,
COMPENSATION OR REIMBURSEMENT
ON ACCOUNT OF THE LOSS OF
PRESENT OR PROSPECTIVE PROFITS
DUE TO FAILURE OF THIS UNIT,
EITHER DURING THE WARRANTY
PERIOD OR AFTER EXPIRATION OF
THE WARRANTY, OR FOR ANY OTHER
REASON WHATSOEVER.

SONY WILL NOT BE LIABLE FOR
CLAIMS OF ANY KIND MADE BY
USERS OF THIS UNIT OR MADE BY
THIRD PARTIES.

SONY WILL NOT BE LIABLE FOR THE
LOSS, REPAIR, OR REPRODUCTION OF
ANY DATA RECORDED ON THE
INTERNAL STORAGE SYSTEM,
RECORDING MEDIA, EXTERNAL
STORAGE SYSTEMS OR ANY OTHER
MEDIA OR STORAGE SYSTEMS.

SONY WILL NOT BE LIABLE FOR THE
TERMINATION OR DISCONTINUATION
OF ANY SERVICES RELATED TO THIS
UNIT THAT MAY RESULT DUE TO
CIRCUMSTANCES OF ANY KIND.
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Software Downloads

When the unit is used with a PC connection,
download device drivers, plug-ins, and
application software, where applicable, from the
Sony Professional products web site.

Sony Professional products web site homepage:

US.A http://pro.sony.com
Canada http://www.sonybiz.ca
Latin America http://sonypro-latin.com
Europe http://www.pro.sony.eu/pro

Middle East and http://sony-psmea.com
Africa

Russia http://sony.ru/pro/

Brazil http://sonypro.com.br
Australia http://pro.sony.com.au
New Zealand http://pro.sony.co.nz
Japan http://www.sonybsc.com
Asia http://pro.sony-asia.com
Korea http://bp.sony.co.kr
China http://pro.sony.com.cn
India http://pro.sony.co.in

Sony Creative Software, software download page
http://www.sonycreativesoftware.com/download/
software_for_sony_equipment



Trademarks

XDCAM is a trademark of Sony Corporation.

* XAVC and are registered trademarks of
Sony Corporation.

* XQD and DCQQD are trademarks of Sony
Corporation.

* HDMI, the HDMI logo, and High-Definition
Multimedia Interface are trademarks or
registered trademarks of HDMI Licensing, LLC
in the United States and/or other countries.

All other company names and product names are
registered trademarks or trademarks of their
respective owners. Trademarked items are not
indicated by ® or ™ symbols in this document.
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